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LATEX [1, 2, 3, 6] ist ein Textsatzsystem, das sich insbesondere für die ”druck-
reife“ Erstellung von wissenschaftlichen Dokumentationen eignet, die mathema-
tische Formeln enthalten. Es kann aber auch für viele andere Arten von Schrift-
stücken verwendet werden, von einfachen Briefen bis zu kompletten Büchern.
LATEX baut auf TEX [8, 9] auf.

Die vorliegende Kurzbeschreibung basiert auf der LATEX-Version LATEX 2ε
vom 1. Juni 1994 und sollte für viele Anwendungen von LATEX ausreichend
sein. Für weitergehende Beschreibungen sei auf den Buchhandel verwiesen,
insbesondere auf den LATEX-Wegweiser [2] und das LATEX-Manual [1].

LATEX ist am Leibniz-Rechenzentrum München auf PCs (unter Windows 95)
sowie auf Unix-Rechnern (Sun-, HP- und IBM-Cluster, Parallelrechner IBM
SP2) installiert. Über die Handhabung von LATEX auf diesen Systemen infor-
mieren die Anhänge A (PC) und B (Unix).

Einrichtungen aus dem Münchener Hochschulbereich sowie deren Angehöri-
ge (Mitarbeiter und Studenten) können das TEX-System (inkl. LATEX) vom LRZ
zur Installation auf eigenen Rechnern erhalten. Für diesen Zweck sind am LRZ
zwei TEX-Implementierungen verfügbar, und zwar das kommerzielle Produkt
PCTEX (für DOS und Windows 3.1/95/NT) und das Public-Domain-Produkt
emTEX (für DOS und OS/2). Informationen zum Bezug sind am WWW-Server
des LRZ zu finden [12].
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Diese Beschreibung wurde mit LATEX 2ε in der Document Class für Artikel mit
dem Paket für deutsche Sprache und mit den LATEX-Befehlen für Titel, Inhalts-
verzeichnis, Abbildungen, Tabellen, Literaturangaben u. dgl. erstellt. Sie dient
also gleichzeitig als Beispiel für die von LATEX standardmäßig unterstützten
Layouts.

Ich danke Michael Hofmann, Rainer Schöpf, Stefan Steffens, Luzia Dietsche und
Bernd Raichle für Tips, Anmerkungen und Korrekturen zur LATEX 2ε-Fassung
dieser Kurzanleitung (J.K.).
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1 Allgemeines

1.1 The Name of the Game

1.1.1 TEX

TEX (sprich ”Tech“, kann auch ”TeX“ geschrieben werden) ist ein Computer-
Progamm von Donald E. Knuth [8, 9]. Es dient zum Setzen und Drucken von
Texten und mathematischen Formeln.

1.1.2 LATEX

LATEX (sprich ”Lah-tech“ oder ”Lej-tech“, kann auch ”LaTeX“ geschrieben wer-
den) ist ein sogenanntes Makro-Paket von Leslie Lamport [1, 2, 3, 6], das TEX
verwendet. Es ermöglicht dem Autor eines Textes, sein Schriftstück in einfa-
cher Weise unter Verwendung eines der vorgefertigten Layouts in Buchdruck-
Qualität zu setzen und auszudrucken.

1.1.3 LATEX 2ε

LATEX 2ε (sprich ”LATEX zwei e“) ist die aktuelle Version von LATEX seit dem
1. Juni 1994. Wenn hier von LATEX gesprochen wird, so trifft das Gesagte sowohl
auf die alte Version LATEX 2.09 als auch auf LATEX 2ε zu, wenn von LATEX 2ε die
Rede ist, gilt das Gesagte nur für LATEX 2ε.

Neue Versionen von LATEX 2ε erscheinen zweimal jährlich im Juni und im
Dezember, manche der hier erwähnten Pakete oder Befehle funktionieren nur
mit Versionen, die jünger als ein (dann erwähnter) Stichtag sind.

1.2 Grundkonzept

1.2.1 Autor, Designer und Setzer

Für eine Publikation übergibt der Autor dem Verleger üblicherweise ein ma-
schinengeschriebenes Manuskript. Der Buch-Designer des Verlages entscheidet
dann über das Layout des Schriftstücks (Länge einer Zeile, Schriftart, Abstände
vor und nach Kapiteln usw.) und schreibt dem Setzer die dafür notwendigen
Steuerdaten dazu.

LATEX ist sozusagen der Buch-Designer, TEX ist sein Setzer. Die eingegebe-
nen LATEX-Befehle werden in um Stufen niedrigere TEX-Setzbefehle übersetzt.

Ein menschlicher Buch-Designer erkennt die Absichten des Autors (z. B.
Kapitel-Überschriften, Zitate, Beispiele, Formeln . . . ) meistens auf Grund sei-
nes Fachwissens aus dem Inhalt des Manuskripts. LATEX dagegen ist ”nur“ ein
Programm und benötigt daher zusätzliche Informationen vom Autor, die die
logische Struktur des Textes angeben. Diese Informationen werden in Form
von sogenannten ”Befehlen“ innerhalb des Textes angegeben.

Im Gegensatz dazu steht ein optischer Entwurf eines Schriftstückes mit
Textverarbeitungsprogrammen wie z. B. Word oder WordPerfect. In diesem
Fall legt der Autor das Layout des Textes bei der interaktiven Eingabe fest. Da-
bei sieht er am Bildschirm das, was auch auf der gedruckten Seite stehen wird.
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Solche Systeme, die optische Entwürfe unterstützen, werden auch WYSIWYG-
Systeme (“what you see is what you get”) genannt.

Bei LATEX sieht der Autor beim Schreiben der Eingabedateien in der Regel
noch nicht, wie der Text nach dem Formatieren aussehen wird. Er kann aber
durch Aufruf des entsprechenden Programms jederzeit einen Probe-Ausdruck
seines Schriftstücks – auf dem Bildschirm oder auf dem Drucker – machen und
danach seine Eingabedatei entsprechend korrigieren und die Arbeit fortsetzen.

1.2.2 Layout-Design

Typographisches Design ist ein Handwerk, das erlernt werden muß. Unge-
übte Autoren machen oft gravierende Formatierungsfehler. Fälschlicherweise
glauben viele Laien, daß Buchdruck-Design vor allem eine Frage der Ästhetik
ist – wenn das Schriftstück vom künstlerischen Standpunkt aus schön aussieht,
dann ist es schon gut ”designed“. Da Schriftstücke jedoch gelesen und nicht
in einem Museum aufgehängt werden, sind die leichtere Lesbarkeit und bessere
Verständlichkeit wichtiger als das schöne Aussehen.

Beispiele: Die Schriftgröße und Numerierung von Überschriften soll so ge-
wählt werden, daß die Struktur der Kapitel und Unterkapitel klar erkennbar ist.
Die Zeilenlänge soll so gewählt werden, daß anstrengende Augenbewegungen des
Lesers vermieden werden, nicht so, daß der Text das Papier möglichst schön
ausfüllt.

Mit interaktiven optischen Entwurfsystemen erzeugen Autoren im allgemei-
nen ästhetisch schöne, aber schlecht strukturierte Schriftstücke. LATEX verhin-
dert solche Formatierungsfehler, indem es den Autor dazu zwingt, die logische
Struktur des Textes anzugeben, und dann automatisch das dafür am besten
geeignete Layout verwendet.

1.2.3 Vor- und Nachteile

LATEX zeichnet sich gegenüber anderen Textverarbeitungsprogrammen vor allem
durch die folgenden Vorteile aus:

• LATEX-Dokumente sind portabel und können daher problemlos zwischen
unterschiedlichen Rechnertypen ausgetauscht werden.

• Es stehen mehrere professionell gestaltete Layouts zur Verfügung, mit
denen die Schriftstücke tatsächlich ”wie gedruckt“ aussehen.

• Das Setzen von mathematischen Formeln ist besonders gut unterstützt.

• Der Anwender muß nur wenige, leicht verständliche Befehle angeben, die
die logische Struktur des Schriftstücks betreffen, und braucht sich um die
Details der drucktechnischen Gestaltung (fast) nicht kümmern.

• Auch komplexe Strukturen wie Fußnoten, Literaturangaben, Inhaltsver-
zeichnisse, Tabellen u. v. a. und sogar einfachere Zeichnungen können ohne
großen Aufwand erstellt werden.
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LATEX hat freilich auch Nachteile:

• Im Unterschied zu WYSIWYG-Systemen ist das fertige Druckbild nicht
direkt sichtbar. Ein Previewing ist erst nach einem Formatierungslauf
(LATEX-Lauf) möglich.

• Innerhalb der von LATEX unterstützten Dokument-Layouts können zwar
einzelne Parameter leicht variiert werden, grundlegende Abweichungen
von den vorgesehenen Layouts sind aber nur mit größerem Aufwand mög-
lich (Design eines neuer ”Document Class“, siehe [13]).

1.3 Eingabedatei

Die Eingabedatei für LATEX ist eine Textdatei. Sie wird mit einem Editor erstellt
und enthält sowohl den Text, der gedruckt werden soll, als auch die Befehle,
aus denen LATEX erfährt, wie der Text gesetzt werden soll.

1.3.1 Leerstellen

”Unsichtbare“ Zeichen wie das Leerzeichen (blank), Tabulatoren (tab) und das
Zeilenende (carriage return) werden von LATEX einheitlich als Leerzeichen be-
handelt. Mehrere Leerzeichen werden wie ein Leerzeichen behandelt. Eine
Leerzeile zwischen Textzeilen bedeutet das Ende eines Absatzes. Mehrere Leer-
zeilen werden wie eine Leerzeile behandelt.

Wenn man andere als die normalen Wort- und Zeilenabstände will, kann
man dies also nicht durch die Eingabe von zusätzlichen Leerzeichen oder Leer-
zeilen erreichen, sondern nur mit entprechenden LATEX-Befehlen.

1.3.2 Spezielle Zeichen

Folgende Symbole sind reservierte Zeichen, die für LATEX eine Spezialbedeutung
haben oder nicht in allen Schriftarten verfügbar sind:

$ & % # _ { } ~ ^ " \ | < >

Die folgenden sieben Zeichen können durch das Voranstellen des Zeichens \
(Backslash) gedruckt werden:

$ & % # { } \$ \& \% \# \_ \{ \}

Die übrigen Symbole und noch viele andere Sonderzeichen können mit speziellen
Befehlen als Akzente oder in mathematischen Formeln gedruckt werden.

1.3.3 LATEX-Befehle

Die meisten LATEX-Befehle haben eines der beiden folgenden Formate: Entweder
sie beginnen mit einem Backslash (\) und haben dann einen nur aus Buchstaben
bestehenden Namen, der durch ein oder mehrere Leerzeichen oder durch ein
nachfolgendes Sonderzeichen oder eine Ziffer beendet wird; oder sie bestehen
aus einem Backslash und genau einem Sonderzeichen oder einer Ziffer. Groß-
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und Kleinbuchstaben haben auch in Befehlsnamen verschiedene Bedeutung.
Wenn man nach einem Befehlsnamen eine Leerstelle erhalten will, muß man {}
zur Beendigung des Befehlsnamens oder einen eigenen Befehl für die Leerstelle
verwenden.

Heute ist der 35. Mai 1987. Oder:
Heute ist der 35. Mai 1987. Falsch
ist: Am 35. Mai 1987regnet es.
Richtig: Am 35. Mai 1987 scheint
die Sonne. Oder: Am 35. Mai 1987
schneit es.

Heute ist der \today.
Oder: Heute ist der \today .
Falsch ist:
Am \today regnet es.
Richtig:
Am \today{} scheint die Sonne.
Oder: Am \today\ schneit es.

Manche Befehle haben Parameter, die zwischen geschweiften Klammern an-
gegeben werden müssen. Manche Befehle haben Parameter, die weggelassen
oder zwischen eckigen Klammern angegeben werden können. Manche Befehle
haben Varianten, die durch das Hinzufügen eines Sterns an den Befehlsnamen
unterschieden werden. Geschweifte Klammern können auch dazu verwendet
werden, Gruppen (groups) zu bilden. Die Wirkung von Befehlen, die innerhalb
von Gruppen oder Umgebungen (environments) angegeben werden, endet im-
mer mit dem Ende der Gruppe bzw. der Umgebung. Im obigen Beispiel ist {}
eine leere Gruppe, die außer der Beendigung des Befehls \today keine Wirkung
hat.

1.3.4 Kommentare

Alles, was hinter einem Prozentzeichen (%) steht (bis zum Ende der Eingabe-
zeile), wird von LATEX ignoriert. Dies kann für Notizen des Autors verwendet
werden, die nicht oder noch nicht ausgedruckt werden sollen.

Das ist ein Beispiel. Das ist ein % dummes
% Besser: ein lehrreiches <----
Beispiel.

1.3.5 Aufbau

Der erste Befehl in einer LATEX 2ε-Eingabedatei muß der Befehl

\documentclass

sein (siehe Abschnitt 1.4.1). Danach können weitere Definitionen folgen, die für
das gesamte Schriftstück gelten sollen. Mit dem Befehl

\begin{document}

beginnt das Setzen des Schriftstücks. Nun folgen der Text und alle LATEX-
Befehle, die das Ausdrucken des Schriftstücks bewirken. Die Eingabe muß mit
dem Befehl

\end{document}
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beendet werden. Falls nach diesem Befehl noch Eingaben folgen, werden sie
von LATEX ignoriert.

Abbildung 1 zeigt eine minimale LATEX 2ε-Datei. Eine etwas kompliziertere
Datei ist in Abbildung 2 skizziert.

1.4 Layout

1.4.1 Document Class

Zu Beginn der Eingabedatei muß das Layout mit

\documentclass[optionen]{klasse}

definiert werden. Die Klasse eines Dokumentes (document class) enthält Ver-
einbarungen über logische Strukturen, z. B. die Gliederungseinheiten (Kapitel
etc.), Listen und Umgebungen, die für alle Dokumente dieser Klasse gemeinsam
sind.

Zwischen den geschweiften Klammern muß eine Document Class angegeben
werden. In Tabelle 1 sind alle Document Classes angeführt, die an jeder LATEX-
Installation als Standardklassen existieren.

Tabelle 1: Document Classes

article für Artikel in wissenschaftlichen Zeitschriften, Vor-
träge, Praktikumsarbeiten, Seminararbeiten, kürze-
re Berichte, Anträge, Gutachten, Programmbeschrei-
bungen, Einladungen u. v. a.

report für längere Berichte, die aus mehreren Kapiteln be-
stehen, Diplomarbeiten, Dissertationen, Skripten u. ä.

book für Bücher

proc für Konferenzbände (Proceedings)

letter für Briefe

slides für Folien. Diese Document Class ersetzt das alte
SliTEX-Format.

Zwischen den eckigen Klammern können, durch Kommata getrennt, eine
oder mehrere Optionen für Varianten der Standard-Layouts angegeben werden.
Die wichtigsten Optionen sind in der Tabelle 2 angeführt.

Die Eingabedatei für diese Beschreibung beginnt z. B. mit

\documentclass[11pt,a4paper,twoside]{article}
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\documentclass{article}
\begin{document}
Small is beautiful.
\end{document}

Abbildung 1: Eine minimale LATEX 2ε-Datei

\NeedsTeXFormat{LaTeX2e}
\documentclass[11pt,a4paper]{article}
\usepackage{german}
\usepackage{a4}

\author{H.~Partl}
\title{"Uber kurz oder lang}

\begin{document}

\maketitle
\begin{abstract}
Beispiel f"ur einen wissenschaftlichen Artikel
in deutscher Sprache.
\end{abstract}

\tableofcontents

\section{Start}

Hier beginnt mein sch"ones Werk\dots

\section{Ende}

\dots\ und hier endet es.

\end{document}

Abbildung 2: Aufbau eines Artikels
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Tabelle 2: Document Class Options

10pt für 10 Punkt hohe Schrift. Dies ist die Voreinstellung.

11pt für 11 Punkte hohe Schrift, wie in dieser Beschreibung.

12pt für 12 Punkt hohe Schrift, das ist etwa die bei Schreib-
maschinen übliche Größe.

Wenn keine dieser Optionen angegeben wird, verwen-
det LATEX 10 Punkte hohe Schrift, was auch eine beim
Buchdruck übliche Größe ist.

a4paper für Papier im DIN A4-Format. Ohne Angabe die-
ser Option nimmt LATEX 2ε amerikanisches Papierfor-
mat an.

fleqn für linksbündige statt zentrierte mathematische Glei-
chungen.

leqno für Gleichungsnummern links statt rechts von jeder
numerierten Gleichung.

titlepage für eine eigene Titelseite (nur bei der Document
Class article).

twocolumn für zweispaltigen Druck.

twoside für Ausgabe mit unterschiedlichen rechten und lin-
ken Seiten.

1.4.2 Pakete

Mit dem Befehl

\usepackage[optionen]{pakete}

können zusätzliche Pakete (packages) geladen werden. Eine Auswahl von Pake-
ten findet sich in der Tabelle 3. Einige der dort aufgeführten Pakete benötigen
die LATEX 2ε-Verteilung vom 1. Dezember 1994 oder neuer.

1.4.3 Page Style

Das Seitenformat kann mit dem Befehl

\pagestyle{style}

festgelegt werden:



1.4 Layout 13

Tabelle 3: Pakete (eine Auswahl)

a4 Anpassung an das DIN A4-Papierformat, die über die
Option a4paper hinausgeht.

array Verbesserte und erweiterte Versionen der Umgebun-
gen array, tabular und tabular*.

float Neue Optionen für Gleitobjekte (Tabellen, Abbildun-
gen etc.), wie genauere Kontrolle über die Plazierung,
Angabe von Stilparametern.

fontenc Erlaubt die Verwendung von Schriften mit unter-
schiedlicher Anordnung/Kodierung.

ftnright Plaziert bei zweispaltigem Layout Fußnoten am
unteren Ende der rechten Spalte.

german Anpassungen für die deutsche Sprache, wie die Ein-
gabe von Umlauten, deutsche Texte in Überschriften,
deutsche Trennung, \frenchspacing (siehe auch Ab-
schnitt 2.4).

graphicx Einbindung von Graphiken und Farbe (falls
möglich) für verschiedene Drucker (siehe auch Ab-
schnitt 4.4).

indentfirst Einzug auch beim ersten Absatz eines Kapi-
tels.

inputenc Deklaration der Zeichenkodierung in der Einga-
bedatei.

latexsym Stellt die LATEX-Symbole wie 2 zur Verfügung.

longtable für Tabellen über mehrere Seiten mit automati-
schem Seitenumbruch.

makeidx Befehle zur automatischen Erstellung eines Index.

multicol Mehrspaltiger Satz mit Kolumnenausgleich.

newlfont Definiert die Befehle \bf, \it etc. so, daß sich
ihre Wirkung kombiniert.

showkeys Druckt die Namen aller verwendeten \labels,
\refs und \pagerefs im Text aus.

theorem Erweiterung der theorem-Umgebung.

verbatim Flexible Erweiterung der verbatim-Umgebung.
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Wird kein \pagestyle angegeben oder plain, steht die Seitennummer in
der Fußzeile. Bei headings stehen Kapitel-Überschrift und Seitennummer in
der Kopfzeile. Bei empty sind Kopf- und Fußzeile leer.

Der Befehl \thispagestyle kennt die gleichen Parameter wie \pagestyle,
wirkt aber nur auf die aktuelle Seite.

Mit \pagenumbering{arabic} bzw. \pagenumbering{roman} kann man
bestimmen, ob für die Seitennumerierung arabische oder römische Ziffern ver-
wendet werden sollen. Als Nebeneffekt wird dabei jeweils die Seitennummer auf
eins zurückgesetzt. Möchte man den Seitenzähler von Hand ändern, so kann
man dies durch den Befehl \setcounter{page}{seitennummer} tun.

Neben der Document Class Option twocolumn (siehe Tabelle 2) gibt es auch
einen \twocolumn-Befehl. Er bewirkt, daß eine neue Seite begonnen wird und
ab dort zweispaltig gesetzt wird. Mit dem Befehl \onecolumn kann man wieder
auf einspaltigen Druck zurückschalten. Im Unterschied zum \twocolumn-Befehl
werden bei Verwendung der Document Class Option twocolumn mehrere Stil-
parameter geeignet verändert. Man sollte daher die Document Class Option
verwenden, wenn der ganze oder überwiegende Teil des Dokuments zweispaltig
gesetzt werden soll.
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2 Setzen von Text

2.1 Zeilen- und Seitenumbruch

2.1.1 Blocksatz

Normaler Text wird im Blocksatz, d. h. mit Randausgleich gesetzt. LATEX führt
den Zeilen- und Seitenumbruch automatisch durch. Dabei wird für jeden Absatz
die bestmögliche Aufteilung der Wörter auf die Zeilen bestimmt, und – wenn
notwendig – werden Wörter automatisch getrennt.

Das Ende von Wörtern und Sätzen
wird durch Leerzeichen gekenn-
zeichnet. Hierbei spielt es keine Rol-
le, ob man ein oder 100 Leerzeichen
eingibt.
Eine oder mehrere Leerzeilen kenn-
zeichnen das Ende von Absätzen.

Das Ende von W"ortern und
S"atzen wird durch Leerzeichen
gekennzeichnet.
Hierbei spielt es keine Rolle,
ob man ein oder 100
Leerzeichen eingibt.

Eine oder mehrere Leerzeilen
kennzeichnen das Ende von
Abs"atzen.

Wie die Absätze gesetzt werden, hängt von der Document Class ab. In Artikeln,
Berichten und Büchern werden Absätze durch das Einrücken der ersten Zeile
dargestellt – so wie in allen anderen Abschnitten dieser Beschreibung. In Briefen
oder wenn man Definitionen der Form

\setlength{\parindent}{0pt}
\setlength{\parskip}{5pt plus 2pt minus 1pt}

angibt, werden Absätze durch vertikalen Abstand ohne horizontales Einrücken
dargestellt – so wie hier in diesem Abschnitt. Als Nebeneffekt werden dabei
auch die Abstände bei den Umgebungen und bei mathematischen Gleichungen
verändert.

Mit Hilfe der in Abschnitt 2.8 beschriebenen Umgebungen ist es möglich, spe-
zielle Textteile jeweils anders zu setzen.

Für Ausnahmefälle kann man den Umbruch außerdem mit den folgenden Be-
fehlen beeinflussen: Der Befehl \\ oder \newline bewirkt einen Zeilenwech-
sel ohne neuen Absatz, der Befehl \\* einen Zeilenwechsel, bei dem kein Sei-
tenwechsel erfolgen darf. Der Befehl \newpage bewirkt einen Seitenwechsel.
Mit den Befehlen \linebreak[n], \nolinebreak[n], \pagebreak[n] und
\nopagebreak[n] kann man angeben, ob an bestimmten Stellen ein Zeilen-
bzw. Seitenwechsel eher günstig oder eher ungünstig ist, wobei n die Stärke der
Beeinflussung angibt (1, 2 oder 3).

Mit dem LATEX 2ε-Befehl \enlargethispage{Länge} läßt sich eine gegebene
Seite um einen festen Betrag verlängern oder verkürzen. Damit ist es möglich,
noch eine Zeile mehr auf eine Seite zu bekommen.
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LATEX bemüht sich, den Zeilenumbruch besonders schön zu machen. Falls es kei-
ne den strengen Regeln genügende Möglichkeit für einen glatten rechten Rand
findet, läßt es eine Zeile zu lang und gibt eine entsprechende Fehlermeldung
aus (“overfull hbox”). Dies tritt insbesondere dann auf, wenn es keine geeigne-
te Stelle für die Silbentrennung findet. Innerhalb der sloppypar-Umgebung ist
LATEX generell weniger streng in seinen Ansprüchen und vermeidet solche über-
lange Zeilen, indem es die Wortabstände stärker – notfalls auch unschön – ver-
größert. In diesem Fall werden zwar Warnungen gemeldet (“underfull hbox”),
das Ergebnis ist aber meistens durchaus brauchbar.

2.1.2 Silbentrennung

Wie weiter oben schon erwähnt, werden Wörter bei Bedarf automatisch ge-
trennt. LATEX verwendet dazu einen Silbentrennungs-Algorithmus, der über
sprachabhängige Trenntabellen gesteuert wird. Die Ansteuerung dieser Tabel-
len geschieht über den TEX-Parameter \language. Bei allen LRZ-Installationen
werden für

\language=0

die englischen, für

\language=1

die deutschen Trennregeln verwendet. \language ist mit 0 (= englisch) vor-
eingestellt und wird bei Verwendung des Pakets german (siehe Abschnitt 2.4)
automatisch auf 1 (= deutsch) gesetzt.

Falls die automatische Silbentrennung in einzelnen Fällen nicht das richtige
Ergebnis liefert, kann man diese Ausnahmen mit den folgenden Befehlen richtig-
stellen. Dies kann insbesondere bei zusammengesetzten oder fremdsprachigen
Wörtern notwendig werden.

Der Befehl \hyphenation bewirkt, daß die darin angeführten Wörter jedes-
mal an den und nur an den mit - markierten Stellen getrennt werden können.
Er sollte am Beginn der Eingabedatei stehen und eignet sich nur für Wörter,
die keine Umlaute, scharfes s, Ziffern oder sonstige Sonderzeichen enthalten.
Beispiel:

\hyphenation{ Eingabe-file
Eingabe-files FORTRAN }

Der Befehl \- innerhalb eines Wortes bewirkt, daß dieses Wort dieses eine
Mal an den und nur an den mit \- markierten Stellen getrennt werden kann.
Dieser Befehl eignet sich für alle Wörter, auch für solche, die Umlaute, schar-
fes s, Ziffern oder sonstige Sonderzeichen enthalten.

Eingabefile, LATEX-Eingabe-
file, Häßlichkeit

Ein\-gabe\-file,
\LaTeX-Eingabe\-file,
H"a"s\-lich\-keit
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Mit dem Paket german [15] steht eine bessere Möglichkeit zur Verfügung,
nämlich der Befehl "-. Dieser erlaubt auch die Trennung an nicht explizit
angegebenen Stellen im Wort (vgl. Abschnitt 2.4).

Für Spezialfälle gibt es auch noch den Befehl \discretionary. Die ersten
beiden Parameter geben die Textteile für den Fall der Trennung an, der dritte
den Text ohne Trennung.1

Drucker oder Druk-
ker

Dru\discretionary{k-}{k}{ck}er

Der Befehl \mbox{...} bewirkt, daß das Argument nicht getrennt werden
kann.

Die Telefonnummer ist nicht mehr
(0222) 5601-3694.
Der Parameter filename gibt den
Dateinamen an.

Die Telefonnummer ist nicht mehr
\mbox{(0222) 5601-3694}. \\
Der Parameter \mbox{\it filename\/}
gibt den Dateinamen an.

Innerhalb des von \mbox eingeschlossenen Textes können Wortabstände für
den notwendigen Randausgleich bei Blocksatz nicht mehr verändert werden.
Ist dies nicht erwünscht, sollte man besser einzelne Wörter oder Wortteile in
\mbox einschließen und diese mit einer Tilde ~, einem untrennbaren Wortzwi-
schenraum (siehe Abschnitt 2.3), verbinden.

2.2 Spezielle Zeichen

2.2.1 Anführungszeichen

Für Anführungszeichen ist nicht das auf Schreibmaschinen übliche Quotes-Zei-
chen (") zu verwenden. Im Buchdruck werden für öffnende und schließende
Anführungszeichen jeweils verschiedene Zeichen bzw. Zeichenkombinationen ge-
setzt. Öffnende englische Anführungszeichen erhält man durch Eingabe von
zwei Grave-Akzenten, schließende durch zwei Apostrophe.

“No,” he said, “I don’t know!” ‘‘No,’’ he said,
‘‘I don’t know!’’

Deutsche Anführungszeichen (”Gänsefüßchen“) sehen anders aus (siehe Ab-
schnitt 2.4).

2.2.2 Binde- und Gedankenstriche

Im Buchdruck werden verschiedene Striche für Bindestriche, Gedankenstriche
und Minus-Zeichen verwendet. Die verschieden langen Striche werden in LATEX
durch Kombinationen von Minus-Zeichen angegeben. Der ganz lange Gedan-
kenstrich (—) wird im Deutschen nicht benutzt, im Englischen wird er ohne
Leerzeichen eingefügt.

1Eine bequemere Möglichkeit für die Angabe von
”
ck“ wird in Abschnitt 2.4 angegeben.
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O-Beine
10–18 Uhr
ja – oder nein?
yes—or no?
0, 1 und −1

O-Beine \\
10--18~Uhr \\
ja -- oder nein? \\
yes---or no? \\
$0, 1$ und $-1$

2.2.3 Punkte

Im Gegensatz zur Schreibmaschine, wo jeder Punkt und jedes Komma mit ei-
nem der Buchstabenbreite entsprechenden Abstand versehen ist, werden Punkte
und Kommata im Buchdruck eng an das vorangehende Zeichen gesetzt. Für
Fortsetzungspunkte (drei Punkte mit geeignetem Abstand) gibt es daher einen
eigenen Befehl \ldots oder \dots.

Nicht so ... sondern so:
Wien, Graz, . . .

Nicht so ... sondern so: \\
Wien, Graz, \dots

2.2.4 Ligaturen

Im Buchdruck ist es üblich, manche Buchstabenkombinationen anders zu setzen
als die Einzelbuchstaben.

ff fi fl AV Te . . . statt ff fi fl AV Te . . .

Diese Ligaturen und Unterschneidungen (kerning) können vermieden wer-
den, indem man zwischen die Buchstaben den Befehl \/ setzt.2 Um die Les-
barkeit des Textes zu verbessern, sollte dies immer dann gemacht werden, wenn
solche Buchstabenkombinationen nach Vorsilben oder bei zusammengesetzten
Wörtern zwischen den Wortteilen auftreten.

Nicht Auflage (Au-fl-age)
sondern Auflage (Auf-lage)

Nicht Auflage (Au-fl-age) \\
sondern Auf\/lage (Auf-lage)

Mit dem Paket german steht zusätzlich der Befehl "| zur Verfügung, der gleich-
zeitig eine Trennhilfe darstellt.

Auflage (Auf-lage) Auf"|lage (Auf-lage)

2.2.5 Akzente und spezielle Buchstaben

LATEX ermöglicht die Verwendung von Akzenten und speziellen Buchstaben aus
zahlreichen verschiedenen Sprachen (siehe Tabelle 4). Akzente werden darin je-
weils am Beispiel des Buchstabens o gezeigt, können aber prinzipiell auf jeden
Buchstaben gesetzt werden. Wenn ein Akzent auf ein i oder j gesetzt wer-
den soll, muß der i-Punkt wegbleiben. Dies erreicht man mit den Befehlen \i
und \j. Seit Juni 1995 steht ein Befehl für eingekreiste Buchstaben und Zahlen
zur Verfügung, \textcircled.

2siehe auch Abschnitt 2.4.
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Tabelle 4: Akzente und spezielle Buchstaben

Eingabe Ausgabe Eingabe Ausgabe

\‘o ò \’o ó
\^o ô \~o õ
\=o ō \.o ȯ
\u o ŏ \v o ǒ
\H o ő \"o ö
\c o o̧ \d o o.
\b o o

¯
\r o o̊

\t oo �oo

\oe œ \OE Œ
\ae æ \AE Æ
\aa å \AA Å
\o ø \O Ø
\l  l \L  L
\i ı \ss ß
\j 

!‘ ¡ ?‘ ¿

Hôtel, näıve, smørebrød.
¡Señorita!
p© 3©

H\^otel, na\"\i ve,
sm\o rebr\o d. \\
!‘Se\~norita!\\
\textcircled{\textsc{p}}
\textcircled{{\small 3}}

2.3 Abstände

Um einen glatten rechten Rand zu erreichen, variiert LATEX die Leerstellen zwi-
schen den Wörtern etwas. Nach Punkten, Fragezeichen u. a., die einen Satz
beenden, wird dabei ein etwas größerer Abstand erzeugt, was die Lesbarkeit
des Textes erhöht. LATEX nimmt an, daß Punkte, die auf einen Großbuchsta-
ben folgen, eine Abkürzung bedeuten, und daß alle anderen Punkte einen Satz
beenden.

Ausnahmen von diesen Regeln muß man LATEX mit den folgenden Befehlen
mitteilen: Ein Backslash (\) vor einem Leerzeichen bedeutet, daß diese Leer-
stelle nicht verbreitert werden darf.

Eine ~ (Tilde) bedeutet eine Leerstelle, an der kein Zeilenwechsel erfolgen
darf. Mit \, läßt sich ein kurzer Abstand erzeugen, wie er z. B. in Abkürzungen
vorkommt.

Der Befehl \@ vor einem Punkt bedeutet, daß dieser Punkt einen Satz be-
endet, obwohl davor ein Großbuchstabe steht.
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Dazu zählen u. a. auch die Österr.
Bundesbahnen.
Dr. Partl wohnt im 1. Stock.
. . . 5 m breit.
Ich brauche Vitamin C. Du nicht?

Dazu z"ahlen u.\,a.\ auch die
"Osterr.\ Bundesbahnen. \\
Dr.~Partl wohnt im 1.~Stock. \\
\dots\ 5~m breit. \\
Ich brauche Vitamin~C\@.
Du nicht?

Außerdem gibt es die Möglichkeit, mit dem Befehl

\frenchspacing

zu vereinbaren, daß die Abstände an Satzenden nicht anders behandelt wer-
den sollen als die zwischen Wörtern. Diese Konvention ist im nicht-englischen
Sprachraum verbreitet. In diesem Fall brauchen die Befehle \ und \@ nicht
angegeben werden. Mit dem Paket german ist \frenchspacing automatisch
gewählt, dies kann durch

\nonfrenchspacing

wieder rückgängig gemacht werden.

2.4 Deutschsprachige Texte

Die in diesem Abschnitt angegebenen Befehle entsprechen der beim 6. Treffen
der deutschen TEX-Interessenten beschlossenen Norm für deutsche TEX- und
LATEX-Befehle [15]. Sie werden durch den Befehl

\usepackage{german}

aktiviert, in der aus Amerika stammenden Originalversion von LATEX stehen
sie nicht zur Verfügung. Beim Austausch von LATEX-Dateien mit anderen In-
stallationen kann es also notwendig sein, das Paket german (d. h. die Datei
german.sty) mitzusenden.

2.4.1 Silbentrennung

LATEX trennt, wenn man nichts anderes angibt, nach englischen Regeln. Bei
Verwendung des Pakets german wird nach deutschen Regeln getrennt (siehe
auch Abschnitt 2.1.2).

2.4.2 Umlaute und scharfes s

In der Originalversion von LATEX gibt es den Befehl \" für Umlaute und \ss
für scharfes s. Man kann deutsche Texte also in der folgenden etwas mühsamen
Form schreiben:

Die häßliche Straße muß schöner
werden.

Die h\"a\ss liche Stra\ss e
mu\ss{} sch\"oner werden.
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Wenn man das Paket german angibt, stehen zusätzlich die folgenden, einfa-
cher verwendbaren Befehle zur Verfügung: Umlaute werden durch Voranstellen
von Quotes geschrieben, also z. B. "o für ”ö“. Für scharfes s schreibt man "s
(ohne Probleme mit nachfolgenden Leerstellen). Damit kann man also schrei-
ben:

Die häßliche Straße muß schöner
werden.

Die h"a"sliche Stra"se
mu"s sch"oner werden.

2.4.3 Anführungszeichen

”Deutsche Gänsefüßchen“ sehen anders aus als “englische Quotes”. In Original-
LATEX kann man versuchen, für deutsche Anführungszeichen unten (links) zwei
Kommata und oben (rechts) zwei Grave-Akzente einzugeben, das Ergebnis ist
aber nicht besonders schön. Statt !‘‘ und ?‘‘ muß man !\/‘‘ bzw. ?\/‘‘
schreiben, weil man sonst die spanischen Sonderzeichen erhalten würde.

,,Nein,“ sagte er, ,,ich weiß nichts!“ ,,Nein,‘‘ sagte er,
,,ich wei\ss{} nichts!\/‘‘

Bei Benutzung des Paketes german stehen die folgenden Befehle für ”richti-
ge“ deutsche Anführungszeichen zur Verfügung: "‘ (Quote und Grave-Akzent)
für Anführungszeichen unten, und "’ (Quote und Apostroph) für Anführungs-
zeichen oben.

”Nein,“ sagte er, ”ich weiß nichts!“ "‘Nein,"’ sagte er,
"‘ich wei"s nichts!"’

2.4.4 Sonstige Befehle

Das Paket german macht einige weitere Befehle verfügbar. Die wichtigsten von
ihnen sind: "ck für ”ck“, das als ”k-k“ getrennt wird, "ff für ”ff“, das als ”ff-f“
getrennt wird (und ebenso für andere Konsonanten), "| zur Vermeidung von
Ligaturen und "~ für einen Bindestrich, an dem kein Zeilenumbruch stattfin-
den soll.

Drucker bzw. Druk-ker
Rolladen bzw. Roll-laden
Auflage
x-beliebig
bergauf und -ab

Dru"cker \\
Ro"lladen \\
Auf"|lage \\
x"~beliebig \\
bergauf und "~ab

2.4.5 Überschriften und Datumsangaben

In der Originalversion von LATEX sind die englischen Bezeichnungen für Kapitel,
Abbildungen, Tabellen, Inhaltsverzeichnis usw. und für Datumsangaben vorein-
gestellt. Dazu werden Befehlsnamen verwendet, die vom Benutzer umdefiniert
werden können [15]. So bewirkt z. B. der Befehl

\renewcommand{\contentsname}{Inhalt}
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Tabelle 5: Überschriften

\contentsname Contents Inhaltsverzeichnis
\listfigurename List of Figures Abbildungsverzeichnis
\listtablename List of Tables Tabellenverzeichnis
\abstractname Abstract Zusammenfassung
\refname References Literatur
\bibname Bibliography Literaturverzeichnis
\indexname Index Index
\figurename Figure Abbildung
\tablename Table Tabelle
\partname Part Teil
\chaptername Chapter Kapitel
\appendixname Appendix Anhang
\pagename Page Seite

daß die Überschrift des Inhaltsverzeichnisses aus dem Wort ”Inhalt“ besteht.
Diese Änderungen werden i. a. nicht direkt in jeder einzelnen LATEX-Eingabe-
datei angegeben, sondern indirekt durch die Angabe eines entsprechenden Pa-
ketes oder eines Befehls wie z. B.

\selectlanguage{\german}

Tabelle 5 enthält eine unvollständige Liste von Befehlsnamen, die in verschie-
denen Klassen verwendet werden, und der Texte, die sie in der englischen Ori-
ginalversion und bei Benutzung des Paketes german enthalten.

2.4.6 Layout

Im deutschen Sprachraum sind zum Teil andere Layouts und Konventionen
üblich als im englischen, z. B. werden Absätze in Artikeln oft nicht durch hori-
zontales Einrücken, sondern durch vertikalen Abstand dargestellt (also so wie
in Abschnitt 2.1.1), oder bei geschachtelten Aufzählungen werden auf der in-
nersten Stufe für die Numerierung nicht römische Zahlen sondern griechische
Buchstaben verwendet.

2.5 Kapitel und Überschriften

Der Beginn eines Kapitels bzw. Unterkapitels und seine Überschrift werden
mit Befehlen der Form \section{...} angegeben. Dabei muß die logische
Hierarchie eingehalten werden.
Bei Artikeln:

\section \subsection \subsubsection

Bei Berichten und Büchern:
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\chapter \section \subsection \subsubsection

Artikel können also relativ einfach als Kapitel in ein Buch eingebaut werden.
Die Abstände zwischen den Kapiteln, die Numerierung und die Schriftgröße der
Überschrift werden von LATEX automatisch bestimmt.

Die Überschrift des gesamten Artikels bzw. die Titelseite des Schriftstücks
wird mit dem Befehl \maketitle gesetzt. Der Inhalt muß vorher mit den
Befehlen \title, \author und \date vereinbart werden (vgl. Abbildung 2 auf
Seite 11).

Der Befehl \tableofcontents bewirkt, daß ein Inhaltsverzeichnis ausge-
druckt wird. LATEX nimmt dafür immer die Überschriften und Seitennummern
von der jeweils letzten vorherigen Verarbeitung der Eingabedatei. Bei einem
neu erstellten oder um neue Kapitel erweiterten Schriftstück muß man das
Programms LATEX also mindestens zweimal aufrufen, damit man die richtigen
Angaben erhält.

Es gibt auch Befehle der Form \section*{...}, bei denen keine Numerie-
rung und keine Eintragung ins Inhaltsverzeichnis erfolgen.

Mit den Befehlen \label und \ref ist es möglich, die von LATEX automa-
tisch vergebenen Kapitelnummern im Text anzusprechen. Für \ref{...} setzt
LATEX die mit \label{...} definierte Nummer ein. Auch hier wird immer die
Nummer von der letzten vorherigen Verarbeitung der Eingabedatei genommen.
Beispiel:

\section{Algorithmen}
...
Der Beweis daf"ur ist in Abschnitt~\ref{bew} angegeben.
...
\section{Beweise} \label{bew}
...

2.6 Fußnoten

Fußnoten3 werden automatisch numeriert und am unteren Ende der Seite aus-
gedruckt.

Fu"snoten\footnote
{Das ist eine Fu"snote.}
werden automatisch ...

2.7 Hervorgehobene Wörter

In maschinengeschriebenen Texten werden hervorzuhebende Texte unterstri-
chen, im Buchdruck werden dafür verschiedene Schriftarten verwendet. Der
Befehl \em (emphasize) schaltet auf die ”hervorstechende“ Schriftart um. Diese
Schriftart bleibt bis zum Ende der aktuellen Gruppe eingeschaltet, der Be-
fehl \em soll daher stets innerhalb von geschweiften Klammern stehen.

3Das ist eine Fußnote.
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Diese Klammer steht vor dem Be-
fehl, nicht nach dem Befehl.

Diese Klammer steht {\em vor\/}
dem Befehl,
{\em nicht nach\/} dem Befehl.

LATEX verwendet für den hervorgehobenen Text kursive Schrift, in der alle Zei-
chen schräg nach rechts geneigt sind. Der Befehl \/ ist notwendig, damit der
letzte schräge Buchstabe nicht in den nachfolgenden geraden Text bzw. Abstand
hineinragt.

Das Nachtlager ist nicht brauchbar.
Das Nacht lager ist nicht häßlich.

Das {\em Nacht}lager
ist {\em nicht} brauchbar. \\
Das {\em Nacht\/}lager
ist {\em nicht\/} h"a"slich.

LATEX 2ε kann in den meisten Fällen die Korrektur automatisch durchführen,
wozu der Befehl

\emph{hervorgehobener Text}

benutzt wird. Sollte die Korrektur nicht erwünscht sein, so ist

\emph{hervorgehobener Text\nocorr}

zu benutzen. Dabei muß \nocorr unmittelbar vor der schließenden Klammer
stehen. LATEX 2ε fügt \nocorr bereits automatisch vor einem Punkt und einem
Komma ein, so daß der Befehl \nocorr nur in Ausnahmefällen benötigt wird.

Werden innerhalb eines hervorgehobenen Textes nochmals Wörter hervor-
gehoben, so nimmt LATEX dafür eine aufrechte Schrift.

2.8 Umgebungen

Die Kennzeichnung von speziellen Textteilen, die anders als im normalen Block-
satz gesetzt werden sollen, erfolgt mittels sogenannter Umgebungen (environ-
ments) in der Form

\begin{name} text \end{name}

Umgebungen sind Gruppen. Sie können auch ineinander geschachtelt werden,
dabei muß aber die richtige Reihenfolge beachtet werden:

\begin{aaa}...\begin{bbb}...\end{bbb}...\end{aaa}

2.8.1 Zitate (quote, quotation, verse)

Die quote-Umgebung eignet sich für kürzere Zitate, hervorgehobene Sätze und
Beispiele. Der Text wird links und rechts eingerückt:
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Eine typographische Faustregel für
die Zeilenlänge lautet:

Keine Zeile soll mehr als
66 Buchstaben enthal-
ten.

Deswegen werden in Zeitungen meh-
rere Spalten nebeneinander verwen-
det.

Eine typographische Faustregel
f"ur die Zeilenl"ange lautet:
\begin{quote}
Keine Zeile soll mehr als
66~Buchstaben enthalten.
\end{quote}
Deswegen werden in Zeitungen
mehrere Spalten nebeneinander
verwendet.

Die quotation-Umgebung unterscheidet sich in den Standardklassen (vgl.
Abbildung 1 auf Seite 10) von der quote-Umgebung dadurch, daß Absätze
durch Einzüge gekennzeichnet werden. Sie ist daher für längere Zitate, die aus
mehreren Absätzen bestehen, geeignet.

Die verse-Umgebung eignet sich für Gedichte und für Beispiele, bei denen
die Zeilenaufteilung wesentlich ist. Die Verse (Zeilen) werden durch \\ getrennt,
Strophen durch Leerzeilen.

2.8.2 Listen (itemize, enumerate, description)

Die Umgebung itemize eignet sich für einfache Listen (siehe Abbildung 3).
Die Umgebung enumerate eignet sich für numerierte Aufzählungen (siehe Ab-
bildung 4). Die Umgebung description eignet sich für Beschreibungen (siehe
Abbildung 5).

Listen:

• Bei itemize werden die Ele-
mente durch Punkte und an-
dere Symbole gekennzeichnet.

• Listen können auch geschach-
telt werden:

– Die maximale Schachte-
lungstiefe ist 4.

– Einrückung und Bezeich-
nung der Elemente wech-
seln automatisch.

• usw.

Listen:
\begin{itemize}

\item Bei \texttt{itemize} werden
die Elemente ...

\item Listen k"onnen auch
geschachtelt werden:

\begin{itemize}
\item Die maximale ...
\item Einr"uckung und ...
\end{itemize}

\item usw.

\end{itemize}

Abbildung 3: Beispiel für itemize
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Aufzählungen:

1. Bei enumerate werden die
Elemente mit Ziffern oder
Buchstaben numeriert.

2. Die Numerierung erfolgt auto-
matisch.

3. Listen können auch geschach-
telt werden:

(a) Die maximale Schachte-
lungstiefe ist 4.

(b) Einrückung und Bezeich-
nung der Elemente wech-
seln automatisch.

4. usw.

Aufz"ahlungen:
\begin{enumerate}

\item Bei \texttt{enumerate} werden
die Elemente ...

\item Die Numerierung ...

\item Listen k"onnen auch
geschachtelt werden:
\begin{enumerate}
\item Die maximale ...
\item Einr"uckung und ...
\end{enumerate}

\item usw.

\end{enumerate}

Abbildung 4: Beispiel für enumerate

Kleine Tierkunde:

Gelse: ein kleines Tier, das östlich
des Semmering Touristen ver-
jagt.

Gemse: ein großes Tier, das west-
lich des Semmering von Touri-
sten verjagt wird.

Gürteltier: ein mittelgroßes Tier,
das hier nur wegen der Länge
seines Namens vorkommt.

Kleine Tierkunde:
\begin{description}
\item[Gelse:]

ein kleines Tier, das ...
\item[Gemse:]

ein gro"ses Tier, das ...
\item[G"urteltier:]

ein mittelgro"ses Tier,
das ...

\end{description}

Abbildung 5: Beispiel für description
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2.8.3 Linksbündig, rechtsbündig, zentriert
(flushleft, flushright, center)

Die Umgebungen flushleft und flushright bewirken links- bzw. rechtsbündi-
gen Satz (”Flattersatz“, d. h. ohne Randausgleich), center setzt den Text in
die Mitte der Zeile. Die einzelnen Zeilen werden durch \\ getrennt. Wenn
man \\ nicht angibt, bestimmt LATEX automatisch die Zeilenaufteilung (siehe
Abbildung 6).

links
Backbord

\begin{flushleft}
links \\
Backbord
\end{flushleft}

rechts
Steuerbord

\begin{flushright}
rechts \\
Steuerbord
\end{flushright}

Im
Reich
der

Mitte

\begin{center}
Im \\ Reich \\ der \\ Mitte
\end{center}

Abbildung 6: Linksbündig, rechtsbündig und zentriert

2.8.4 Direkte Ausgabe (verbatim, verb)

Zwischen \begin{verbatim} und \end{verbatim} stehende Zeilen werden ge-
nauso ausgedruckt, wie sie eingegeben wurden, d. h. mit allen Leerzeichen und
Zeilenwechseln und ohne Interpretation von Spezialzeichen und LATEX-Befehlen.
Dies eignet sich z. B. für das Ausdrucken eines (kurzen) Computer-Programms.

Innerhalb eines Absatzes können einzelne Zeichenkombinationen oder kur-
ze Textstücke ebenso ”wörtlich“ ausgedruckt werden, indem man sie zwischen
\verb| und | einschließt. Mit diesen Befehlen wurden z. B. alle LATEX-Befehle
in der vorliegenden Beschreibung gesetzt.

Der \dots-Befehl . . . Der \verb|\dots|-Befehl \dots

Die verbatim-Umgebung und der Befehl \verb dürfen nicht innerhalb von
Parametern von anderen Befehlen verwendet werden.
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Abbildung 7: R. Black, Ganz in weiß

2.8.5 Abbildungen (figure)

Zwischen \begin{figure} und \end{figure} stehender Text – bzw. der mit
\vspace angegebene Platz für das Einkleben eines Bildes – wird automatisch
an eine Stelle gesetzt, wo er komplett hinpaßt, ohne durch einen Seitenwech-
sel zerrissen zu werden. Mit \caption{...} setzt man die Bezeichnung der
Abbildung. Dabei ist nur der Text anzugeben, das Wort ”Abbildung“ und die
fortlaufende Nummer werden von LATEX hinzugefügt. Bei Abbildungen ist es
allgemein üblich, die Bezeichnung unter das Bild zu setzen. Mit \label und
\ref kann man die Nummer der Abbildung im Text ansprechen.

Abbildung 7 zeigt ein Beispiel aus
der Pop-Art.

Abbildung~\ref{weiss} zeigt ein
Beispiel aus der Pop-Art.
\begin{figure}[htbp]
\vspace{6cm}
\caption{R.~Black, Ganz

in wei"s} \label{weiss}
\end{figure}

Die Plazierung einer Abbildung kann beeinflußt werden, indem man eine be-
liebige Kombination der folgenden Kennbuchstaben als zusätzlichen Parameter
angibt:

h (here) an der Stelle der figure-Umgebung
t (top) am Kopf einer Seite
b (bottom) am Fuß einer Seite
p (page) auf einer eigenen Seite für Abbildungen

Wird dieser Parameter angegeben, muß er unmittelbar hinter \begin{figure}
stehen, eingeschlossen in eckige Klammern [...]. Wird der Parameter wegge-
lassen, so gilt tbp als Voreinstellung (”plaziere die Abbildung am Seitenanfang;
falls das nicht möglich ist, am Seitenende oder – falls auch das nicht geht – auf
einer eigenen Seite“).
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Eine Abbildung, die nicht plaziert werden konnte, wird von LATEX immer
weiter nach hinten verschoben (und schiebt alle weiteren Abbildungen vor sich
her!), bis ein neues Kapitel beginnt, das Dokument zu Ende ist, oder der Befehl

\clearpage

eingegeben wird.
LATEX 2ε kennt einen weiteren Plazierungsparameter, ! ‘bang’, der vorüber-

gehend alle Plazierungsbeschränkungen aufhebt. Bang muß immer zusammen
mit mindestens einem der vier anderen Parameter benutzt werden.

Der Befehl \label muß nach dem \caption-Befehl stehen, sonst stimmt
die Numerierung nicht.

2.8.6 Tafeln (table)

Tafeln werden analog zu den Abbildungen zwischen \begin{table} und
\end{table} gesetzt. Die Befehle \caption, \label und \ref wirken analog.
Bei Tafeln sind beide möglichen Konventionen verbreitet: Die Bezeichnung wird
entweder immer über oder immer unter die Tafel gesetzt.

Für das Zusammensetzen der Tafel wird meistens die tabbing- oder die
tabular-Umgebung verwendet, die im folgenden beschrieben werden. Man
kann aber auch andere Strukturen (z. B. enumerate oder description) oder
beliebigen Text verwenden. Abbildung 8 enthält eine Skizze für eine solche
Schachtelung von Umgebungen.

\begin{table}
\caption{...} \label{...}

\begin{center}
\begin{tabular}{...}
...
\end{tabular}

\end{center}
\end{table}

Abbildung 8: Aufbau einer table-Umgebung

2.8.7 Tabulatoren (tabbing)

In der tabbing-Umgebung kann man Tabulatoren ähnlich wie an Schreibma-
schinen setzen und verwenden. Der Befehl \= setzt eine Tabulatorposition,
\kill bedeutet, daß die ”Musterzeile“ nicht ausgedruckt werden soll, \> springt
zur nächsten Tabulatorposition, und \\ trennt die Zeilen.
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links Mittelteil rechts
Es
war einmal und ist nicht mehr
ein ausgestopfter

Teddybär

\begin{tabbing}
war einmal\quad \=
Mittelteil\quad \= \kill
links \> Mittelteil \> rechts\\
Es \\
war einmal \> und ist
\> nicht mehr\\
ein \> \> ausgestopfter\\
\> \> Teddyb"ar
\end{tabbing}

2.8.8 Tabellen (tabular)

Die tabular-Umgebung dient zum Setzen von Tabellen, bei denen LATEX au-
tomatisch die benötigte Spaltenbreite bestimmt, und bei der auch spezielle Ei-
genschaften wie Rechtsbündigkeit und Hilfslinien vereinbart werden können.

Im Parameter des Befehls \begin{tabular}{...} wird das Format der Ta-
belle angegeben. Dabei bedeutet l eine Spalte mit linksbündigem Text, r eine
mit rechtsbündigem, c eine mit zentriertem Text, p{breite} eine Spalte der
angegebenen Breite mit mehrzeiligem Text, | einen senkrechten Strich.

Innerhalb der Tabelle bedeutet & den Sprung in die nächste Tabellenspalte,
\\ trennt die Zeilen, \hline (an Stelle einer Zeile) setzt einen waagrechten
Strich.

7C0 hexadezimal
3700 oktal

11111000000 binär
1984 dezimal

\begin{tabular}{|rl|}
\hline
7C0 & hexadezimal \\
3700 & oktal \\
11111000000 & bin"ar \\
\hline\hline
1984 & dezimal \\
\hline
\end{tabular}

2.9 Literaturangaben

Mit der thebibliography-Umgebung kann man ein Literaturverzeichnis druk-
ken. Darin beginnt jede Literaturangabe mit \bibitem. Als Parameter wird
ein Name vereinbart, unter dem die Literaturstelle im Text mit \cite zitiert
werden kann, und dann folgt der Text der Literaturangabe. Die Numerierung
erfolgt automatisch. Der Parameter bei \begin{thebibliography} gibt die
maximale Breite dieser Nummernangabe an, also z. B. {99} für maximal zwei-
stellige Nummern.

Das Zitieren der Literaturstelle im Text erfolgt jeweils mit dem Befehl
\cite. Beispiel:
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Partl [1] hat vorgeschlagen, daß . . .

Literatur

[1] H. Partl: German TEX, TUG-
boat Vol. 9, No. 1 (1988)

Partl~\cite{pa} hat
vorgeschlagen, da"s ...

\begin{thebibliography}{99}
\bibitem{pa}
H.~Partl: \textit{German \TeX,}
TUGboat Vol.~9, No.~1 (1988)
\end{thebibliography}

Anstelle einer durchlaufenden Numerierung des Literaturverzeichnisses kann
man auch eigene Marken für die Titel verwenden. Dazu ist beim \bibitem-
Befehl ein zusätzlicher Parameter anzugeben.

Partl [Part 88] hat vorgeschlagen,
daß . . .

Literatur

[Part 88] H. Partl: German TEX,
TUGboat Vol. 9, No. 1
(1988)

Partl~\cite{pa} hat
vorgeschlagen, da"s ...

\begin{thebibliography}{Abcd 99}
\bibitem[Part 88]{pa}
H.~Partl: \textit{German \TeX,}
TUGboat Vol.~9, No.~1 (1988)
\end{thebibliography}
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3 Setzen von mathematischen Formeln

3.1 Allgemeines

Mathematische Textteile innerhalb eines Absatzes werden zwischen \( und \)
oder zwischen $ und $ oder zwischen \begin{math} und \end{math} einge-
schlossen. Als mathematische Texte gelten sowohl komplette mathematische
Formeln als auch einzelne Variablennamen, die sich auf Formeln beziehen, grie-
chische Buchstaben, das Hoch- und Tiefstellen von Texten und diverse Sonder-
zeichen.

Seien a und b die Katheten und c die
Hypotenuse, dann gilt c2 = a2 + b2

(Pythagoräischer Lehrsatz).

Seien $a$ und $b$ die Katheten
und $c$ die Hypotenuse,
dann gilt $c^{2}=a^{2}+b^{2}$
(Pythagor"aischer Lehrsatz).

TEX spricht man wie τεχ aus.

100 m2 Nutzfläche

Mit ♥-lichen Grüßen

\TeX\ spricht man wie
$\tau\epsilon\chi$ aus.\\
100~m$^{2}$ Nutzfl"ache \\
Mit $\heartsuit$-lichen
Gr"u"sen

Größere mathematische Formeln oder Gleichungen setzt man besser in ei-
gene Zeilen. Wenn sie keine Gleichungsnummer erhalten sollen, stellt man sie
dazu zwischen \begin{displaymath} und \end{displaymath} oder zwischen
\[ und \]; wenn sie eine Gleichungsnummer erhalten sollen, stellt man sie
zwischen \begin{equation} und \end{equation}.

Seien a und b die Katheten und c die
Hypotenuse, dann gilt

c =
√
a2 + b2 (1)

(Pythagoräischer Lehrsatz).

Seien $a$ und $b$ die Katheten
und $c$ die Hypotenuse,
dann gilt
\begin{equation}
c = \sqrt{ a^{2}+b^{2} }
\end{equation}
(Pythagor"aischer Lehrsatz).

Mit \label und \ref kann man die Gleichungsnummern im Text anspre-
chen.

ε > 0 (2)

Aus (2) folgt . . .

\begin{equation} \label{eps}
\varepsilon > 0
\end{equation}

Aus (\ref{eps}) folgt \dots

Das Setzen im mathematischen Modus unterscheidet sich vom Text-Modus
vor allem durch folgende Punkte:
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1. Leerstellen und Zeilenwechsel haben bei der Eingabe keine Bedeutung, alle
Abstände werden nach der Logik der mathematischen Ausdrücke automa-
tisch bestimmt oder müssen durch spezielle Befehle wie \, oder \qquad
angegeben werden.

∀x ∈ R : x2 ≥ 0 (3)
\begin{equation}
\forall x \in \mathbf{R}:
\qquad x^{2} \geq 0
\end{equation}

2. Leerzeilen sind verboten (Mathematische Formeln müssen innerhalb eines
Absatzes stehen).

3. Jeder einzelne Buchstabe wird als Name einer Variablen betrachtet und
entsprechend gesetzt (kursiv mit zusätzlichem Abstand). Will man inner-
halb eines mathematischen Textes normalen Text (in aufrechter Schrift,
mit Wortabständen) setzen, muß man diesen in \textrm{...} einschlie-
ßen.

x2 ≥ 0 für alle x ∈ R (4)

\begin{equation}
x^{2} \geq 0\qquad
\textrm{f"ur alle }
x \in \mathbf{R}
\end{equation}

3.2 Elemente in mathematischen Formeln

In diesem Abschnitt werden die wichtigsten Elemente, die in mathematischen
Formeln verwendet werden, kurz beschrieben. Eine Liste aller verfügbaren Sym-
bole enthält Abschnitt 3.5.

Kleine griechische Buchstaben werden als \alpha, \beta, \gamma,
\delta, usw. eingegeben, große griechische Buchstaben als \mathrm{A},
\mathrm{B}, \Gamma, \Delta, usw.

λ, ξ, π, µ,Φ,Ω $\lambda, \xi, \pi, \mu,
\Phi, \Omega $

Weiters gibt es eine Fülle von mathematischen Symbolen: von ∈ über
⇒ bis ∞ (siehe Abschnitt 3.5).

Mathematische Symbole können in LATEX 2ε aus einer Auswahl von Alpha-
beten genommen werden.

ABCabc
ABCabc
ABCabc
ABCabc
ABC

$\mathrm{ABCabc}$ \\
$\mathbf{ABCabc}$ \\
$\mathsf{ABCabc}$ \\
$\mathtt{ABCabc}$ \\
$\mathcal{ABC}$
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Die kalligraphischen Buchstaben (\mathcal) gibt es nur als Großbuchstaben.
Die Euler Fraktur Fonts erhält man durch Laden des Pakets eufrak, das
den Alphabetbefehl \mathfrak definiert.

ABCabc $\mathfrak{ABCabc}$

Exponenten und Indizes können mit den Zeichen ^ und _ hoch- bzw.
tiefgestellt werden.

a1 x2 e−αt a3
ij $a_{1}$ \qquad

$x^{2}$ \qquad
$e^{-\alpha t}$ \qquad
$a^{3}_{ij}$

Das Wurzelzeichen wird mit \sqrt, n-te Wurzeln werden mit \sqrt[n]
eingegeben. Die Größe des Wurzelzeichens wird von LATEX automatisch ge-
wählt.

√
x

√
x2 +

√
y 3

√
2 $\sqrt{x}$ \qquad

$\sqrt{ x^{2}+\sqrt{y} }$
\qquad $\sqrt[3]{2}$

Die Befehle \overline und \underline bewirken waagrechte Striche
direkt über bzw. unter einem Ausdruck.

m+ n $\overline{m+n}$

Die Befehle \overbrace und \underbrace bewirken waagrechte Klam-
mern über bzw. unter einem Ausdruck.

a+ b+ · · ·+ z︸ ︷︷ ︸
26

$\underbrace{a+b+\cdots+z}_{26}$

Um mathematische Akzente wie Pfeile oder Schlangen auf Variablen zu
setzen, gibt es die in Tabelle 6 auf Seite 39 angeführten Befehle. Längere
Tilden und Dächer, die sich über mehrere (bis zu 3) Zeichen erstrecken können,
erhält man mit \widetilde bzw. \widehat. Ableitungszeichen werden mit ’
(Apostroph) eingegeben.

y = x2 y′ = 2x y′′ = 2

\begin{displaymath}
y=x^{2} \qquad
y’=2x \qquad
y’’=2
\end{displaymath}

Mathematische Funktionen werden in der Literatur üblicherweise nicht
kursiv (wie die Namen von Variablen), sondern in ”normaler“ Schrift darge-
stellt. LATEX stellt die folgenden Befehle für mathematische Funktionen zur
Verfügung:
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\arccos \cos \csc \exp \ker \limsup \min \sinh
\arcsin \cosh \deg \gcd \lg \ln \Pr \sup
\arctan \cot \det \hom \lim \log \sec \tan
\arg \coth \dim \inf \liminf \max \sin \tanh

Für die Modulo-Funktion gibt es zwei verschiedene Befehle: \bmod für den
binären Operator a mod b und \pmod{...} für die Angabe in der Form x ≡ a
(mod b).

lim
x→0

sinx
x

= 1

\begin{displaymath}
\lim_{x \to 0} \frac{\sin x}{x}
=1
\end{displaymath}

Ein Bruch (fraction) wird mit dem Befehl \frac{...}{...} gesetzt. Für
einfache Brüche kann man aber auch den Operator / verwenden.

11
2 Stunden

x2

k + 1
x

2
k+1 x1/2

$1\frac{1}{2}$~Stunden
\begin{displaymath}
\frac{ x^{2} }{ k+1 } \qquad
x^{ \frac{2}{k+1} } \qquad
x^{ 1/2 }
\end{displaymath}

Binomial-Koeffizienten können in der Form {...\choose...} gesetzt
werden. Mit dem Befehl \atop erhält man das Gleiche ohne Klammern.

(
n

k

)
x

y + 2

\begin{displaymath}
{ n \choose k } \qquad
{ x\atop y+2 }
\end{displaymath}

Das Integralzeichen wird mit \int eingegeben, das Summenzeichen mit
\sum. Die obere und untere Grenze wird mit ^ bzw. _ wie beim Hoch-/Tief-
stellen angegeben.

Normalerweise werden die Grenzen neben das Integralzeichen gesetzt (um
Platz zu sparen), durch Einfügen des Befehls \limits wird erreicht, daß die
Grenzen oberhalb und unterhalb des Integralzeichens gesetzt werden.

Beim Summenzeichen hingegen werden die Grenzen bei der Angabe von
\nolimits oder im laufenden Text neben das Summenzeichen gesetzt, anson-
sten aber unter- und oberhalb.

n∑
i=1

∫ π
2

0

+∞∫
−∞

\begin{displaymath}
\sum_{i=1}^{n} \qquad
\int_{0}^{\frac{\pi}{2}} \qquad
\int \limits_{-\infty}^{+\infty}
\end{displaymath}
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Für Klammern und andere Begrenzer gibt es in TEX viele verschiedene
Symbole (z. B. [ 〈 ‖ l). Runde und eckige Klammern können mit den ent-
sprechenden Tasten eingegeben werden, geschweifte mit \{, die anderen mit
speziellen Befehlen (z. B. \updownarrow).

Setzt man den Befehl \left vor öffnende Klammern und den Befehl \right
vor schließende, so wird automatisch die richtige Größe gewählt.

1 +
(

1
1− x2

)3

\begin{displaymath}
1 + \left( \frac{1}{ 1-x^{2} }

\right) ^3
\end{displaymath}

In manchen Fällen möchte man die Größe der Klammern lieber selbst fest-
legen, dazu sind die Befehle \bigl, \Bigl, \biggl und \Biggl anstelle von
\left und analog \bigr etc. anstelle von \right anzugeben.

(
(x+ 1)(x− 1)

)2

\begin{displaymath}
\Bigl( (x+1) (x-1) \Bigr) ^{2}
\end{displaymath}

Um in Formeln 3 Punkte (z. B. für 1, 2, . . . , n) auszugeben, gibt es die
Befehle \ldots und \cdots. \ldots setzt die Punkte auf die Grundlinie (low),
\cdots setzt sie in die Mitte der Zeilenhöhe (centered). Außerdem gibt es die
Befehle \vdots für vertikal und \ddots für diagonal angeordnete Punkte.

x1, . . . , xn x1 + · · ·+ xn

\begin{displaymath}
x_{1},\ldots,x_{n} \qquad
x_{1}+\cdots+x_{n}
\end{displaymath}

3.3 Nebeneinander Setzen

Wenn man mit den von TEX gewählten Abständen innerhalb von Formeln
nicht zufrieden ist, kann man sie mit expliziten Befehlen verändern. Die wich-
tigsten sind \, für einen sehr kleinen Abstand, \ für einen mittleren, \quad
und \qquad für große Abstände sowie \! für die Verkleinerung eines Abstands.

Fn = Fn−1 + Fn−2 n ≥ 2

\begin{displaymath}
F_{n} = F_{n-1} + F_{n-2}
\qquad n \ge 2
\end{displaymath}

∫∫
D
dx dy statt

∫ ∫
D
dxdy

\begin{displaymath}
\int\!\!\!\int_{D} dx\,dy
\quad \textrm{statt} \quad
\int\int_{D} dx dy
\end{displaymath}
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3.4 Übereinander Setzen

Für Matrizen u. ä. gibt es die array-Umgebung, die ähnlich wie die tabular-
Umgebung funktioniert. Der Befehl \\ trennt die Zeilen.

X =

 x11 x12 . . .
x21 x22 . . .

...
...

. . .


\begin{displaymath}
\mathbf{X} =
\left( \begin{array}{ccc}
x_{11} & x_{12} & \ldots \\
x_{21} & x_{22} & \ldots \\
\vdots & \vdots & \ddots
\end{array} \right)
\end{displaymath}

\left und \right müssen stets paarweise auftreten. Soll eine der beiden
Klammern entfallen, kann man sich dadurch helfen, daß man unmittelbar hinter
\left bzw. \right einen ”.“ setzt.

x =

{
y falls y > 0
z + y sonst

\begin{displaymath}
x =
\left\{ \begin{array}{ll}
y & \textrm{falls $y>0$} \\
z+y & \textrm{sonst}
\end{array} \right.
\end{displaymath}

Für mehrzeilige Formeln oder Gleichungssysteme verwendet man die Um-
gebungen eqnarray und eqnarray* statt equation. Bei eqnarray erhält je-
de Zeile eine eigene Gleichungsnummer, bei eqnarray* wird ebenso wie bei
displaymath keine Nummer hinzugefügt. Für Gleichungssysteme, die eine ge-
meinsame Nummer erhalten sollen, kann man eine array-Umgebung innerhalb
der equation-Umgebung verwenden.

Die Umgebungen eqnarray und eqnarray* funktionieren wie eine 3-spaltige
Tabelle der Form {rcl}, wobei die mittlere Spalte für das Gleichheits- oder
Ungleichheitszeichen verwendet wird, nach dem die Zeilen ausgerichtet werden
sollen. Der Befehl \\ trennt die Zeilen.

f(x) = cosx (5)
f ′(x) = − sinx (6)∫ x

0
f(y)dy = sinx (7)

\begin{eqnarray}
f(x) & = & \cos x \\
f’(x) & = & -\sin x \\
\int_{0}^{x} f(y)dy &
= & \sin x
\end{eqnarray}

Für Gleichungssysteme, die eine gemeinsame Nummer erhalten sollen, kann
man innerhalb der equation-Umgebung eine array-Umgebung verwenden.
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sin2 x+ cos2 x = 1
sinx · cosx = 1

(8)

\begin{equation}
\begin{array}{rcl}
\sin^{2}x+\cos^{2}x & = & 1 \\
\sin x \cdot \cos x & = & 1
\end{array}
\end{equation}

Zu lange Gleichungen werden von LATEX nicht automatisch abgeteilt.
Der Autor muß bestimmen, an welcher Stelle abgeteilt und wie weit einge-
rückt werden soll. Meistens verwendet man dafür eine der beiden folgenden
Varianten:

sinx = x− x3

3!
+
x5

5!
−

− x7

7!
+ · · · (9)

\begin{eqnarray}
\sin x & = & x -\frac{x^{3}}{3!}

+\frac{x^{5}}{5!} - {}
\nonumber\\

& &{} -\frac{x^{7}}{7!} + \cdots
\end{eqnarray}

cosx = 1− x2

2!
+

+
x4

4!
− x6

6!
+ · · · (10)

\begin{eqnarray}
\lefteqn{ \cos x = 1

-\frac{x^{2}}{2!} +{} }
\nonumber\\

& &{} +\frac{x^{4}}{4!}
-\frac{x^{6}}{6!} + \cdots

\end{eqnarray}

Der Befehl \nonumber bewirkt, daß an diese Stelle keine Gleichungsnummer
gesetzt wird. Der Befehl \lefteqn ermöglicht Ausnahmen von der Spaltenauf-
teilung innerhalb eqnarray. Genauere Informationen enthalten [1, 3].

3.5 Liste der mathematischen Symbole

In den folgenden Tabellen sind alle Symbole angeführt, die standardmäßig im
mathematischen Modus verwendet werden können. Die mit ∗ versehenen Sym-
bole sind in LATEX 2ε nur mit dem Paket latexsym verwendbar. Viele weitere
Symbole stehen zur Verfügung, wenn man das Paket amssymb verwendet (siehe
z. B. [6]).
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Tabelle 6: Mathematische Akzente

\hat a â \check a ǎ
\tilde a ã \acute a á
\grave a à \dot a ȧ
\ddot a ä \breve a ă
\bar a ā \vec a ~a

Tabelle 7: Kleine griechische Buchstaben

α \alpha ι \iota % \varrho
β \beta κ \kappa σ \sigma
γ \gamma λ \lambda ς \varsigma
δ \delta µ \mu τ \tau
ε \epsilon ν \nu υ \upsilon
ε \varepsilon ξ \xi φ \phi
ζ \zeta o o ϕ \varphi
η \eta π \pi χ \chi
θ \theta $ \varpi ψ \psi
ϑ \vartheta ρ \rho ω \omega

Tabelle 8: Große griechische Buchstaben

Γ \Gamma Ξ \Xi Φ \Phi
∆ \Delta Π \Pi Ψ \Psi
Θ \Theta Σ \Sigma Ω \Omega
Λ \Lambda Υ \Upsilon
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Tabelle 9: Verschiedene sonstige Symbole (∗ benötigt Paket latexsym)

ℵ \aleph ′ \prime ∀ \forall
h̄ \hbar ∅ \emptyset ∃ \exists
ı \imath ∇ \nabla ¬ \neg
 \jmath

√
\surd [ \flat

` \ell > \top \ \natural
℘ \wp ⊥ \bot ] \sharp
< \Re ‖ \| ♣ \clubsuit
= \Im 6 \angle ♦ \diamondsuit
∂ \partial 4 \triangle ♥ \heartsuit
∞ \infty \ \backslash ♠ \spadesuit
0 \mho∗ 2 \Box∗ 3 \Diamond∗

Tabelle 10: ”Große“ Operatoren∑ ∑
\sum

⋂ ⋂
\bigcap

⊙ ⊙
\bigodot∏ ∏

\prod
⋃ ⋃

\bigcup
⊗ ⊗

\bigotimes∐ ∐
\coprod

⊔ ⊔
\bigsqcup

⊕ ⊕
\bigoplus∫ ∫

\int
∨ ∨

\bigvee
⊎ ⊎

\biguplus∮ ∮
\oint

∧ ∧
\bigwedge
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Tabelle 11: Binäre Operatoren

+ + − -
± \pm ∩ \cap ∨ \vee
∓ \mp ∪ \cup ∧ \wedge
\ \setminus ] \uplus ⊕ \oplus
· \cdot u \sqcap 	 \ominus
× \times t \sqcup ⊗ \otimes
∗ \ast / \triangleleft � \oslash
? \star . \triangleright � \odot
� \diamond o \wr † \dagger
◦ \circ © \bigcirc ‡ \ddagger
• \bullet 4 \bigtriangleup q \amalg
÷ \div 5 \bigtriangledown

Tabelle 12: Relationen (∗ benötigt Paket latexsym)

< < > > = =
≤ \leq ≥ \geq ≡ \equiv
≺ \prec � \succ ∼ \sim
� \preceq � \succeq ' \simeq
� \ll � \gg � \asymp
⊂ \subset ⊃ \supset ≈ \approx
⊆ \subseteq ⊇ \supseteq ∼= \cong
v \sqsubseteq w \sqsupseteq ./ \bowtie
∈ \in 3 \ni 1 \Join∗

` \vdash a \dashv |= \models
^ \smile | \mid

.= \doteq
_ \frown ‖ \parallel ⊥ \perp
< sqsubset∗ = sqsupset∗ ∝ \propto
� \lhd∗ � \unlhd∗ � \rhd∗

� \unrhd∗



42 3 SETZEN VON MATHEMATISCHEN FORMELN

Tabelle 13: Negationen

6< \not< 6> \not> 6= \not=
6≤ \not\leq 6≥ \not\geq 6≡ \not\equiv
6≺ \not\prec 6� \not\succ 6∼ \not\sim
6� \not\preceq 6� \not\succeq 6' \not\simeq
6⊂ \not\subset 6⊃ \not\supset 6≈ \not\approx
6⊆ \not\subseteq 6⊇ \not\supseteq 6∼= \not\cong
6v \not\sqsubseteq 6w \not\sqsupseteq 6� \not\asymp

Tabelle 14: Pfeile (∗ benötigt Paket latexsym)

← \leftarrow ←− \longleftarrow ↑ \uparrow
⇐ \Leftarrow ⇐= \Longleftarrow ⇑ \Uparrow
→ \rightarrow −→ \longrightarrow ↓ \downarrow
⇒ \Rightarrow =⇒ \Longrightarrow ⇓ \Downarrow
↔ \leftrightarrow ←→ \longleft... l \updownarrow
⇔ \Leftrightarrow ⇐⇒ \Longleft... m \Updownarrow
7→ \mapsto 7−→ \longmapsto ↗ \nearrow
←↩ \hookleftarrow ↪→ \hookrightarrow ↘ \searrow
↼ \leftharpoonup ⇀ \rightharpoonup ↙ \swarrow
↽ \leftharpoondown ⇁ \rightharpoondown↖ \nwarrow
⇀↽ \rightleftharpoons ; \leadsto∗

Tabelle 15: Klammern

( ( ) ) d \lceil e \rceil
〈 \langle 〉 \rangle b \lfloor c \rfloor
[ [ ] ] { \{ } \}
[ \lbrack ] \rbrack { \lbrace } \rbrace
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Tabelle 16: Synonyme

Für manche Symbole stehen mehrere verschiedene Befehle zur Verfügung.

6= \ne or \neq \not=
≤ \le \leq
≥ \ge \geq
{ \{ \lbrace
} \} \rbrace
→ \to \rightarrow
← \gets \leftarrow
3 \owns \ni
∧ \land \wedge
∨ \lor \vee
¬ \lnot \neg
| \vert |
‖ \Vert \|

Tabelle 17: Nicht-mathematische Symbole

Die folgenden Symbole sind im Text-Modus verfügbar:

† \dag § \S c© \copyright
‡ \ddag ¶ \P £ \pounds
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4 Spezialitäten

Das komplette Menü der Spezialitäten, die von LATEX serviert werden, ist in
[1, 3] beschrieben. Hier soll nur auf einige besondere ”Bonbons“ hingewiesen
werden.

4.1 Schriftarten und -größen (Fonts)

Normalerweise wählt LATEX die geeigneten Schriftarten und Schriftgrößen auf
Grund der Befehle aus, die die logische Struktur des Textes angeben (Über-
schriften, emphasize usw.). In Spezialfällen kann die Schriftart und -größe auch
explizit mit den in den Tabellen 18 und 19 angeführten Befehlen gewechselt
werden.

Die Verwendung dieser Befehle erfolgt analog zum Befehl \em innerhalb
von Gruppen, für kurze Textstücke sollen die Formen \text..., die wie der
Befehl \emph ein Argument haben, benutzt werden.

Die kleinen fetten Römer beherrschten
das ganze große Italien.

le 2ième régime

{\small Die kleinen
\textbf{fetten} R"omer
beherrschten }{\large das
ganze gro"se \textit{Italien}.}
\\
le \(2^{\textrm{\scriptsize

i\‘eme}}\) r\’egime

Die Größen-Befehle verändern auch die Zeilenabstände auf die jeweils da-
zu passenden Werte – aber nur, wenn die Leerzeile, die den Absatz beendet,
innerhalb des Gültigkeitsbereichs des Größenbefehls liegt. Damit korrekte Zei-
lenabstände verwendet werden, darf daher die schließende geschweifte Klammer
nicht zu früh kommen, sondern erst nach einer Leerzeile oder einem explizit mit
dem Befehl \par eingefügten Absatzende!

Je weniger verschiedene Schriftarten man verwendet, desto lesbarer und
schöner wird das Schriftstück.

Tabelle 18: Schriftarten

\textrm \rm normale Schrift (roman)
\textsf \sf Serifenlose Schrift (sans serif)
\texttt \tt Schreibmaschinenschrift (typewriter)
\textbf \bf fette Schrift (boldface)
\textit \it kursive Schrift (italic)
\textsl \sl schräge Schrift (slanted)
\textsc \sc Kapitälchen (Caps and Small Caps)
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Tabelle 19: Schriftgrößen

\tiny winzig kleine Schrift

\scriptsize sehr kleine Schrift (wie Indizes)

\footnotesize kleine Schrift (wie Fußnoten)

\small kleine Schrift
\normalsize normale Schrift
\large große Schrift
\Large größere Schrift
\LARGE sehr große Schrift
\huge riesig groß
\Huge gigantisch

4.2 Abstände

4.2.1 Zeilenabstand

Um in einem Schriftstück größere Zeilenabstände, als in der Document Class
vorgesehen ist, zu verwenden, gibt es in LATEX 2ε den Befehl \linespread:

für ”eineinhalbzeilige“ Ausgabe:
\linespread{1.3}

für ”doppelzeilige“ Ausgabe:
\linespread{1.6}

4.2.2 Spezielle horizontale Abstände

Die Abstände zwischen Wörtern und Sätzen werden von LATEX automatisch
gesetzt. Sonstige horizontale Abstände kann man mit dem Befehl

\hspace{länge}

bewirken. Wenn der Abstand auch am Beginn oder Ende einer Zeile erhalten
bleiben soll, muß \hspace* statt \hspace geschrieben werden. Die Längenanga-
be besteht im einfachsten Fall aus einer Zahl und einer Einheit. Die wichtigsten
Einheiten sind in Tabelle 20 angeführt.

Hier ist 1.5 cm Abstand. Hier\hspace{1.5cm}ist 1.5~cm
Abstand.

Die Befehle in Tabelle 21 sind Abkürzungen für spezielle horizontale Ab-
stände. Der Befehl \hfill kann dazu dienen, einen vorgegebenen Platz auszu-
füllen. Beispiele für die Verwendung von \, und \hfill:

” ,Parsifal‘ dauert länger als ,Cats‘.“ "‘\,,Parsifal‘ dauert l"anger
als ,Cats‘."’
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Tabelle 20: Einheiten für Längenangaben

mm Millimeter
cm Zentimeter = 10 mm
in Inch ≈ 25 mm
pt Point ≈ 1

72 in ≈ 1
3 mm

em proportional zur Zeichenbreite des aktuellen Fonts
ex proportional zur Zeichenhöhe des aktuellen Fonts

Tabelle 21: Horizontale Abstände

\, ein sehr kleiner Abstand
\enspace so breit wie eine Ziffer
\quad so breit, wie ein Buchstabe hoch ist (”weißes Quadrat“)
\qquad doppelt so breit wie ein \quad
\hfill ein Abstand, der sich von 0 bis ∞ ausdehnen kann.

links rechts links\hfill rechts

4.2.3 Spezielle vertikale Abstände

Die Abstände zwischen Absätzen, Kapiteln usw. werden von LATEX automatisch
bestimmt. In Spezialfällen kann man zusätzliche Abstände zwischen zwei Ab-
sätzen mit dem Befehl

\vspace{länge}

bewirken. Dieser Befehl sollte immer zwischen zwei Leerzeilen angegeben wer-
den. Wenn der Abstand auch am Beginn oder Ende einer Seite erhalten bleiben
soll, muß \vspace* statt \vspace geschrieben werden. Die Befehle in Tabel-
le 22 sind Abkürzungen für spezielle vertikale Abstände. Der Befehl \vfill in

Tabelle 22: Vertikale Abstände

\smallskip etwa 1
4 Zeile

\medskip etwa 1
2 Zeile

\bigskip etwa 1 Zeile
\vfill ein Abstand, der sich von 0 bis ∞ ausdehnen kann
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Verbindung mit \pagebreak[4] kann dazu dienen, Text an den unteren Rand
einer Seite zu setzen oder vertikal zu zentrieren.

Zusätzliche Abstände zwischen zwei Zeilen innerhalb eines Absatzes oder
einer Tabelle erreicht man mit dem Befehl

\\[länge]

4.3 Briefe (letter)

Wenn man als Document Class letter angibt, kann man zwischen \begin{doc-
ument} und \end{document} einen oder mehrere Briefe schreiben.

Mit \signature und \address definiert man Name und Adresse des Absen-
ders. \begin{letter}{...} beginnt einen Brief an den im Parameter mit Na-
me und Adresse angegebenen Empfänger. \opening{...} und \closing{...}
schreiben die Anrede und den abschließenden Gruß, an den automatisch die
mit \signature vereinbarte Unterschrift angefügt wird. \end{letter} been-
det den jeweiligen Brief.

Wenn man vor \begin{document} den Befehl \makelabels angibt, werden
außerdem Adreß-Etiketten erzeugt.

Abbildung 9 enthält ein Beispiel für einen Brief.

\documentclass[12pt,a4paper]{letter}
\usepackage{german}
\address{EDV-Zentrum der TU Wien \\

Abt.~Digitalrechenanlage \\
Wiedner Hauptstra"se 8--10 \\ A-1040 Wien }

\signature{Dr.~Hubert Partl}
\begin{document}
\begin{letter}{Frau Mag.~Elisabeth Schlegl \\

EDV-Zentrum der Karl-Franzens-Universit"at \\
Attemsgasse 25/II \\ A-8010 Graz}

\opening{Liebe Frau Schlegl,}
herzlichen Dank f"ur die Zusendung .....

..... in etwa 2--3~Wochen fertig zu sein.
\closing{Mit freundlichen Gr"u"sen}
\end{letter}
\end{document}

Abbildung 9: Brief von H. P. an E. S.

4.4 Einbinden von Grafiken (graphicx)

Das Paket graphicx [7, 14] bietet eine standardisierte, geräteunabhängige
Schnittstelle für das Einbinden von Grafiken in LATEX-Dokumente. Allerdings
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unterstützen leider nicht alle Treiber alle Features von graphicx. Das Paket
wird bereitgestellt durch

\usepackage[treiber]{graphicx}

Dabei ist als treiber das Programm anzugeben, das für die Ausgabe verwendet
wird. Bei den LRZ-Installationen von LATEX kommen dafür konkret in Betracht:

dvips, falls das gleichnamige Treiberprogramm verwendet wird (siehe An-
hang A.3 bzw. B.3). Bei Benutzung von dvips können PostScript- und
Encapsulated PostScript-Grafiken eingebunden werden (d. h. Dateien mit
den Erweiterungen .ps und .eps). dvips unterstützt alle Features des
Pakets graphicx.

pctexwin, falls PCTEX for Windows verwendet wird (siehe Anhang A.1).
PCTEX for Windows erlaubt neben den beiden PostScript-Formaten (.ps
und .eps) zusätzlich die MS-Windows-Formate Bitmap Image File (.bmp)
und Meta File (.wmf). Nachteilig ist, daß PCTEX for Windows nicht alle
Features des graphicx-Pakets unterstützt (z. B. ist kein Rotieren möglich)
und das Einbinden von Bildern in der Praxis nicht so zuverlässig funktio-
niert wie mit dvips.

Das eigentliche Einbinden von Grafiken geschieht durch den Befehl

\includegraphics[optionen]{datei}

Beim Einbinden einer EPS-Grafik werden Höhe und Breite des Bildes der Boun-
ding Box der betreffenden Datei entnommen und automatisch berücksichtigt.
Bei allen anderen Grafikformaten muß man durch die Optionen

natheight=höhe,natwidth=breite

selbst dafür sorgen, daß angemessen Platz freigehalten wird. Weitere wichtige
Optionen sind:

height=höhe (Grafik auf die angegebene Höhe skalieren)
width=breite (Grafik auf die angegebene Breite skalieren)
keepaspectratio (Grafik nicht verzerren, falls height und width

angegeben werden)
draft (Grafik nicht einbinden, nur Platz freilassen)
scale=faktor (um den angegebenen Faktor skalieren)
angle=winkel (Grafik gegen den Uhrzeigersinn um den angegebe-

nen Winkel rotieren; wird von PCTEX for Windows nicht un-
terstützt)

Beispiel: Abbildung 10 auf Seite 51 dieser Schrift wurde wie folgt eingebunden:

\begin{figure}[hb]
\includegraphics[width=\textwidth]{pctex.eps}
\caption{Die PC\TeX-Oberfl"ache}
\label{pctexwindow}

\end{figure}

Durch die Option width=\textwidth wurde dafür gesorgt, daß die Grafik genau
auf Zeilenbreite skaliert wird.
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4.5 Robuste und zerbrechliche Befehle

Die meisten LATEX-Befehle sind ”robust“, d. h. sie liefern immer das gewünschte
Ergebnis.

Es gibt aber auch sogenannte ”zerbrechliche“ Befehle, die in bestimmten Si-
tuationen (innerhalb von sogenannten ”bewegten“ Parametern) nur dann rich-
tig funktionieren, wenn man den Befehl \protect voranstellt. Zu den zer-
brechlichen Befehlen zählen unter anderem die in Tabelle 19 auf Seite 45 an-
geführten Befehle, die die Schriftgröße verändern, die Befehle \cite, \ref und
\pageref für Literatur- und Querverweise und der Befehl \footnote. Es gibt
also einige wenige (und sehr selten auftretende) Spezialfälle, in denen man z. B.
\protect\cite statt \cite schreiben muß. Wann solche Spezialfälle auftreten,
ist in [1, 3] beschrieben.

4.6 Kompatibilität zu LATEX 2.09

Fast alle mit der alten Version LATEX 2.09 erstellten Dokumente lassen sich
mit LATEX 2ε fehlerfrei übersetzen. An dem Befehl \documentstyle erkennt
LATEX 2ε die alte Version und verwendet dann einen speziellen Kompatibilitäts-
modus, in dem die Erweiterungen abgeschaltet sind.

In LATEX 2.09 geschriebene Dokumente lassen sich meistens sehr leicht nach
LATEX 2ε portieren. Hierzu ist die Zeile

\documentstyle[optionen]{stil}

durch die entsprechende Angabe

\documentclass[optionen]{klasse}

zu ersetzen. Dabei ist zu beachten, daß LATEX 2ε zwischen Option und Pa-
ket (package) unterscheidet und die meisten ”Stiloptionen“ von LATEX 2.09 zu
Paketen in LATEX 2ε werden, die mit

\usepackage{pakete}

geladen werden. Die meisten Stiloptionen von LATEX 2.09 lassen sich unver-
ändert mit LATEX 2ε als Pakete weiterverwenden. Einige alte Optionen funktio-
nieren nur dann als Pakete, wenn vorher das Paket rawfonts geladen wurde.

Ferner sollten alle Schriftwechsel, insbesondere in Formeln, von {\rm ...}
auf \textrm{...} bzw. \mathrm{...} umgestellt werden.

4.7 BibTEX: Ein Werkzeug zum Erstellen
von Literaturverzeichnissen

BibTEX [1, 2, 3, 6, 16, 17] ist ein Programm von Oren Patashnik, mit dessen Hil-
fe man aus bibliographischen Datenbanken ein Literaturverzeichnis extrahieren
kann.

LATEX unterstützt sowohl einen manuellen Aufbau von Literaturverzeich-
nissen (ohne BibTEX) als auch eine automatische Erzeugung (mit BibTEX).
Für den manuellen Aufbau dient das Environment thebibliography (siehe
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Abschnitt 2.9). Dessen Verwendung und der Verzicht auf BibTEX ist völlig
adäquat, wenn man LATEX nur für wenige Arbeiten verwendet (z. B. für die Di-
plomarbeit). Verwendet man LATEX jedoch öfter, und zitiert auch immer wieder
aus derselben Menge von Literatur, so empfiehlt sich der Einsatz von BibTEX.
In diesem Fall speichert man sämtliche Literaturangaben in bibliographischen
Datenbanken ab (BIB-Dateien), und braucht dann im LATEX-Dokument ledig-
lich noch anzugeben, welche Datenbanken durchsucht werden sollen (\biblio-
graphy-Befehl) und in welchem Layout das Literaturverzeichnis gesetzt werden
soll (\bibliographystyle-Befehl).

4.8 MakeIndex: Ein Indexprozessor für LATEX

MakeIndex [1, 2, 3, 6, 11] ist ein Programm von Pehong Chen, das den LATEX-
Benutzer bei der Erstellung von Indexregistern unterstützt.

LATEX kennt einen Befehl \index zur Kennzeichnung von Indexeinträgen so-
wie ein Environment theindex, in dem die für die Erstellung des Indexregisters
notwendigen LATEX-Befehle anzugeben sind. MakeIndex bildet das Bindeglied
zwischen beiden, indem es die Indexeinträge sortiert und eine fertige theindex-
Umgebung generiert.



51

A LATEX an Windows-PCs

Dieser Anhang beschreibt die Handhabung von LATEX an PCs, die unter der
Oberfläche PCTEX for Windows laufen. Diese TEX-Implementierung wird an
LRZ-PCs eingesetzt und steht im Rahmen einer Campuslizenz allen Einrichtun-
gen aus dem Münchener Hochschulbereich sowie deren Angehörige (Mitarbeiter
und Studenten) zur Installation auf eigenen Rechnern zur Verfügung. Informa-
tionen zum Bezug sind am WWW-Server des LRZ zu finden [12].

A.1 Arbeiten mit PCTEX for Windows

Das Programm PCTEX for Windows bietet eine integrierte Oberfläche für al-
le Arbeitsschritte, die beim ”LATEXen“ notwendig sind: Für das Editieren von
LATEX-Eingabedateien, das Formatieren dieser Dateien mit LATEX, das Anschau-
en der daraus erzeugten DVI-Dateien auf dem Bildschirm (”Previewing“) sowie
das Ausdrucken von DVI-Dateien auf einem angeschlossenen Drucker. Außer-
dem steht eine Online-Hilfe zur Verfügung.

An LRZ-PCs, die unter Windows 95 laufen, kann PCTEX for Windows wie
folgt über das Startmenü aufgerufen werden:

Start→ Programme→ Textverarbeitung→ PCTEX→ PCTEX 2.1 (Win)

Abbildung 10 zeigt die PCTEX-Oberfläche mit integriertem Editor und Pre-
viewer.

Abbildung 10: Die PCTEX-Oberfläche

Die wichtigsten Funktionen von PCTEX for Windows sind über die Buttons
in der Toolbar-Leiste abrufbar. Die Wirkung dieser Buttons wird im folgenden
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kurz beschrieben; dabei wird jeweils in Klammern angegeben, wie die betref-
fende Funktion über die Menüleiste erreichbar ist.

Die ersten beiden Button-Gruppen enthalten die bei Windows-Applikatio-
nen üblichen Datei- und Editor-Funktionen:

Neue LATEX-Datei anlegen (File → New)

LATEX-Datei öffnen (File → Open . . . )

LATEX-Datei speichern (File → Save)

Markierten Text ausschneiden und in die Zwischenablage legen
(Edit → Cut)

Markierten Text in die Zwischenablage legen (Edit → Copy)

Inhalt der Zwischenablage an der Cursorposition einfügen (Edit→ Paste)

Die beiden nächsten Buttons dienen dem eigentlichen Typesetting:

Menü, über das das gewünschte Format für das Typeset-
ting eingestellt werden kann (Typeset → Select Current Format)

Formatierungslauf anstoßen, und zwar unter Verwendung des aktuell
eingestellten Formats (Typeset → Typeset Using Current Format)

Funktionen für das Betrachten von DVI-Dateien auf dem Bildschirm bieten die
beiden nächsten Button-Gruppen:

DVI-Datei ”previewen“ (File → View DVI . . . )

Zoom-Stufe so wählen, daß die Seite bezüglich ihrer Breite genau in das
Fenster paßt (View → Zoom to fit Page Width)

Vergrößerungsglas. Drückt man diesen Button, so verwandelt sich der
Cursor in eine Lupe, mit der man über die Seite wandern kann. Durch
nochmaliges Drücken des Buttons wird die Lupenfunktion wieder ausge-
schaltet (View → Magnifying Box)

Nächst kleinere Zoom-Stufe wählen (View → Zoom Down)

Nächst größere Zoom-Stufe wählen (View → Zoom Up)

Vorherige Seite anschauen (View → Last Page)

Nächste Seite anschauen (View → Next Page)

Abgeschlossen wird die Toolbar-Leiste durch zwei Einzelbuttons:

DVI-Datei ausdrucken (File → Print DVI . . . )

Online-Hilfe (Help → Index)
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A.2 Aufruf der LATEX-Tools BibTEX und MakeIndex

Die beiden LATEX-Tools BibTEX (siehe Abschnitt 4.7) und MakeIndex (siehe
Abschnitt 4.8) sind an LRZ-PCs in PCTEX for Windows integriert und über
das Tools-Menü zugänglich. Bei beiden Tools erscheint nach dem Aufruf ein
Dateiauswahlmenü, über das man die zu bearbeitende Datei selektieren muß.
Dabei erwartet BibTEX eine Datei mit der Erweiterung .aux, MakeIndex eine
Datei mit der Erweiterung .idx.

A.3 Aufruf des PostScript-Treibers dvips

Wenn man mit PCTEX for Windows arbeitet, wird man zum Ausdrucken ei-
nes LATEX-Dokuments in der Regel die integrierte Druckfunktion verwenden
(Button ). Bei manchen Dokumenten ist es aber notwendig oder sinnvoll,
stattdessen den externen PostScript-Treiber dvips zu benutzen. Dies ist ins-
besondere ratsam,

• wenn große Dokumente ausgegeben werden (dvips erzeugt deutlich
kompakteres PostScript und ist außerdem schneller als der integrierte
Windows-Treiber),

• wenn Grafiken eingebunden werden (dvips unterstützt im Gegensatz zu
PCTEX for Windows den vollen Funktionsumfang des Pakets graphicx
und funktioniert problemloser).

dvips ist an LRZ-PCs innerhalb von PCTEX for Windows über das Tools-
Menü zugänglich. Klickt man dvips dort an, erscheint ein Dateiauswahlmenü,
über das man die zu bearbeitende DVI-Datei selektieren muß. Möchte man
dvips man bestimmten Optionen starten, so muß man vor dem Aufruf folgendes
tun:

Auswahl von Settings → Configure Tools,
Anklicken von &DVIPS,
Eintragen der Optionen im Feld Additional Parameters.

Bitte beachten Sie, daß ein Eintrag in diesem Feld solange gilt, bis er explizit
wieder geändert oder gelöscht wird. Wenn Sie PCTEX an einem LRZ-PC nut-
zen, sollten Sie daher eventuell vorgenommene Eintragungen unbedingt wieder
löschen bevor Sie den PC verlassen. Der nächste PCTEX-Benutzer am betreffen-
den PC, der sich sonst über ein ”merkwürdiges“ Verhalten von dvips wundern
würde, wird es Ihnen danken!

Ein ausführliche Beschreibung von dvips findet man in [18], eine Beschrei-
bung der wichtigsten Optionen in Anhang B.3.
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B LATEX an Unix-Rechnern

LATEX ist am Leibniz-Rechenzentrum derzeit (Stand: 15.11.97) an folgenden
Unix-Systemen installiert: am Sun-, am HP- und am IBM-Cluster sowie am
Parallelrechner IBM SP2. In diesem Anhang wird die Handhabung von LATEX
an diesen Rechnern beschrieben.

B.1 Wichtige Kommandos

Tabelle 23 enthält eine Übersicht über die wichtigsten Kommandos, die man
beim Arbeiten mit LATEX benötigt. Sie stehen an den oben genannten Unix-
Systemen des LRZ im Verzeichnis /client/bin zur Verfügung.

Beim Aufruf der Kommandos darf die Dateinamenerweiterung weggelassen
werden, wenn es sich um die Standarderweiterung handelt. Man darf also z. B.
statt ”latex story.tex“ kurz ”latex story“ oder statt ”xdvi story.dvi &“
kurz ”xdvi story &“ schreiben, da LATEX-Dateien standardmäßig auf ”.tex“
und DVI-Dateien standardmäßig auf ”.dvi“ enden.

B.2 Previewing unter X-Window mit xdvi

Mit xdvi kann man mit LATEX formatierte Dokumente (bzw. allgemein DVI-
Dateien) unter X-Window ”previewen“. Das Programm wird aufgerufen durch

xdvi [<Optionen>] <DVI-Datei> &

Einige Eigenschaften von xdvi:

• Das Programm bietet die Möglichkeit, die Ausgabe bezüglich mehrerer
(Integer-)Faktoren zu skalieren. Es existiert ein Vergrößerungsglas zur
Betrachtung eines kleinen Ausschnittes des Bildschirms in maximaler Ver-
größerung.

• xdvi kann über Tastatureingaben, aber auch durch das Anklicken von
Buttons am rechten Rand des Fensters bedient werden. Es existieren
Scroll-Bars zur Bewegung des Bildes im Fenster.

• Während des Previewing kann die Re-Initialisierung des Programms und
das erneute Einlesen der DVI-Datei angestoßen werden. Dadurch können
nacheinander mehrere Versionen einer DVI-Datei betrachtet werden, ohne
daß xdvi ständig neu gestartet werden muß.

B.2.1 Optionen beim Aufruf von xdvi

Es sollen hier nur die wichtigsten Optionen des Previewers aufgeführt werden.
Die vollständige Liste läßt sich in der man-page xdvi(1) nachlesen.

+n gibt die erste anzuzeigende Seite an. Wird + ohne Seitennummer
angegeben, erscheint die letzte Seite. Voreinstellung: erste Seite
des Dokuments.
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Tabelle 23: LATEX-Kommandos an Unix-Rechnern des LRZ

latex Formatierung der Eingabedatei mit LATEX.
Aufruf: latex <LATEX-Datei>

tex Formatierung der Eingabedatei mit Plain-TEX.
Aufruf: tex <TEX-Datei>

xdvi Preview-Programm zum Anschauen von DVI-Dateien unter
X-Window.
Aufruf: xdvi [<Optionen>] <DVI-Datei> &
Siehe auch Abschnitt B.2

dvips PostScript-Druckertreiber für DVI-Dateien.
Aufruf: dvips [<Optionen>] <DVI-Datei>
Siehe auch Abschnitt B.3

bibtex LATEX-Tool zum Erstellen von Literaturverzeichnissen.
Aufruf: bibtex [<Optionen>] <AUX-Datei>
Siehe auch Abschnitt 4.7 sowie man-page bibtex(1)

makeindex Allgemeines Tool zur Indexerstellung, das insbesondere in
Verbindung mit LATEX verwendbar ist.
Aufruf: makeindex [<Optionen>] <IDX-Datei>
Siehe auch Abschnitt 4.8 sowie man-page makeindex(1)

latex2html LATEX- nach HTML-Konverter.
Aufruf: latex2html [<Optionen>] <LATEX-Datei>
Weitere Infos: latex2html -h

mf Metafont, ein Programm zur Erzeugung von TEX-Fonts
(xdvi und dvips rufen Metafont automatisch auf, wenn ein
benötigter Font nicht vorhanden ist).
Aufruf: mf [<Optionen>] <Metafont-Datei>
Aufruf und weitere Infos siehe man-page mf(1)

dviconcat Konkatenieren von DVI-Dateien
(am Sun-Cluster nicht verfügbar).
Aufruf und weitere Infos siehe man-page dviconcat(1)

dviselect Extrahieren gewisser Seiten aus DVI-Dateien
(am Sun-Cluster nicht verfügbar).
Aufruf und weitere Infos siehe man-page dviselect(1)
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-s n legt den Skalierungsfaktor fest, der beim Aufruf von xdvi aktiv
sein soll. Es sind die Werte 1 bis 4 möglich. Voreinstellung ist 3.

-hush unterdrückt alle xdvi-Warnungen (z. B. über undefinierte spe-
cials und im Font nicht vorhandene Zeichen).

-expert unterdrückt die Anzeige der Buttons.

-density n legt die Strichstärke der Buchstaben fest. Die Angabe erfolgt in
Prozent, höhere Werte führen zu dünneren Buchstaben. Vorein-
stellung ist 40.

-xoffset <Dim> Festlegung des horizontalen Offset. Die Maßeinheit muß
sich ohne Leerraum an den angegebenen Zahlenwert anschließen.
Erlaubt sind die Angaben in (Inch) und cm (Zentimeter). Vorein-
stellung: 1.0in.

-yoffset <Dim> Festlegung des vertikalen Offset. Die Maßeinheit muß sich
ohne Leerraum an den angegebenen Zahlenwert anschließen. Er-
laubt sind die Angaben in (Inch) und cm (Zentimeter). Voreinstel-
lung: 1.0in.

-paper <Format> Erlaubt sind u. a. folgende Formatangaben:

legal: 8.5× 14 Inch
a1–a7: ISO-Formate A1 bis A7
a1r–a7r: A1 bis A7 im Querformat (rotated)

Voreinstellung: a4.

-mgs[n] <Pixel × Pixel> legt die Größe der Lupe in Pixeln fest, die bei der
Betätigung des Mouse-Buttons n erscheint.
Voreinstellungen: 200× 150, 400× 250, 700× 500.

B.2.2 xdvi-Kommandos

Die Bedienung von xdvi kann sowohl mit der Maus (durch Anklicken der
Buttons) als auch über Tastatureingaben erfolgen. Ist ein Skalierungsfaktor
ungleich eins eingestellt, impliziert das Drücken einer Maustaste im Anzeige-
Fenster das Erscheinen eines Vergrößerungsglases, welches sich durch Bewegen
der Maus verschieben läßt und verschwindet, sobald die Maustaste losgelas-
sen wird. Durch Anklicken der Scroll-Bars kann der sichtbare Seitenausschnitt
verändert werden.

Alternativ sind u. a. folgende Tastatureingaben verwendbar. Einigen von
ihnen kann eine positive oder negative ganze Zahl vorausgehen.

q ”quit“: Beenden von xdvi
Identische Wirkung: CRTL C , CRTL D

n ”next“: Sprung zur nächsten Seite. Steht eine ganze Zahl vor dem
n, wird entsprechend viele Seiten weitergeblättert.
Identische Wirkung: f, SPACE , RETURN , LF
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p ”previous“: Sprung zur vorhergehenden Seite. Steht eine ganze
Zahl vor dem p, wird entsprechend viele Seiten zurückgeblättert.
Identische Wirkung: b, CRTL H

g ”given number“: Es wird die Seite mit der angegebenen (physi-
schen) Nummer aufgeschlagen. Wird keine Zahl vor dem g ange-
geben, erscheint die letzte Seite.

^ ”home“: Die aktuelle Seite wird vom oberen Rand beginnend an-
gezeigt.
Identische Wirkung: HOME

u, ↑ ”up“: Scrollen des Bildschirms nach oben.

d, ↓ ”down“: Scrollen des Bildschirms nach unten.

l, ← ”left“: Scrollen des Bildschirms nach links.

r, → ”right“: Scrollen des Bildschirms nach rechts.

s ”shrink“: setzt den Skalierungsfaktor auf den angegebenen Wert.

S setzt die Strichstärke bei skalierter Anzeige der gerasterten Fonts.

R ”re-read“: erzwingt ein erneutes Einlesen und Aufbereiten der
DVI-Datei.
Identische Wirkung: CRTL L

x ”expert“: wirkt als Schalter zur Anzeige bzw. Nichtanzeige der
Buttons.

B.3 Erzeugung von PostScript-Dateien mit dvips

Mit Hilfe von dvips können mit LATEX formatierte Dokumente (bzw. allge-
mein DVI-Dateien) nach PostScript konvertiert werden. Das Programm wird
aufgerufen durch

dvips [<Optionen>] <DVI-Datei>

Nachfolgend die wichtigsten Optionen von dvips (eine vollständige Liste findet
man in der man-page dvips(1) sowie in [18]):

-pn bewirkt, daß die Ausgabe bei der Seite n beginnt. Voreinstellung:
Ausgabe ab der ersten Seite des Dokuments.

-nn bewirkt, daß höchstens n Seiten ausgegeben werden. Voreinstel-
lung: 100 000.

-ln bewirkt, daß die Ausgabe bei der Seite n endet. Voreinstellung:
Ausgabe bis zur letzten Seite des Dokuments.

-cn bewirkt, daß jede Seite n-mal ausgegeben wird: zuerst n-mal die
erste Seite, dann n-mal die zweite Seite, usw. Voreinstellung ist 1.
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-Cn bewirkt, daß das Dokument im ganzen n-mal ausgegeben wird.
Die Ausgabe dauert in diesem Falle länger als bei Verwendung
der Option -c, geht aber schneller als eine n-malige Ausgabe der
PostScript-Datei. Voreinstellung ist 1.

-h <Dateiname> bewirkt, daß die angegebene Datei als zusätzliche Header-
Datei im Rahmen des PostScript userdict ausgegeben wird.

-m legt fest, daß der Einzug der Blätter über die manuelle Zuführung
erfolgen soll.

-o <Dateiname> bewirkt, daß auf die angegebene Datei ausgegeben wird. Die
Angabe des Dateinamens ist optional. Wenn der Dateiname fehlt,
wird eine Datei mit dem Zusatz ”.ps“ erzeugt.

-O <xDim>,<yDim> verschiebt den Abstand zwischen Text und linkem bzw.
oberem Blattrand, und zwar um <xDim> in der horizontalen und
um <yDim> in der vertikalen Richtung. <xDim> und <yDim>
können u. a. in mm (Millimeter), cm (Zentimeter) und in (Inches)
angegeben werden. Bei Angabe von positiven Werten wird der
Text nach rechts bzw. nach unten verschoben, bei Angabe von
negativen Werten nach links bzw. nach oben.

-q schaltet in den ”Quiet Mode“: Es werden nur Fehlermeldungen
ausgegeben, sonst nichts.

-r bewirkt, daß die Seiten in umgekehrter Reihenfolge ausgegeben
werden.

-xn erlaubt eine globale Vergrößerung des Dokuments (um den Faktor
n/1000). Bei Verwendung der Original-TEX-Schriften sind nur Ver-
größerungen sinnvoll, für die entsprechende Fontdateien existieren.
Voreinstellung ist die in der DVI-Datei angegebene Vergrößerung.
Für LATEX-Dokumente ist dies stets 1000 (keine Vergrößerung).
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